FCC Information
WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user's authority to operate this equipment.

FCC Class A Compliance
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates,
and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

Industry Canada Class A Notice
This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de l'Industrie Canada
Cet appareil numerique de la Classe A est conforme a la norme NMB-003 du Canada.

Certificate by Manufacturer/Importer
This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.

Bescheinigung des Herstellers/Importeurs
Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstorn ist. Der Deutschen Bundespost wurde
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingerannt.

RFI Compliance Notice
This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstörebestimmungen
getriift. Es ist jedoch moglich, dass die Funk-entstörebestimmungen unter ungunstigen Umstenden bei anderen Geratekombinationen nicht eingehalten
werden. Fuer die Einhaltung der Funk-entstörebestimmungen seign gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Software License Agreement
Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE
ACCEPTED THE TERMS OF THIS AGREEMENT. If you cannot or do not accept these terms, you may return the entire package within ten (10) days to the
Distributor or Dealer from which you obtained them for a full refund.

Electronics For Imaging grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation ("Software") included with
the RIP Station you have purchased, including without limitation the PostScript software provided by Adobe Systems Incorporated.

You may:
a. use the Software solely for your own customary business purposes and solely with RIP Station;
b. use the digitally-encoded machine-readable outline and bitmap programs ("Font Programs") provided with RIP Station in a special encrypted format ("Coded
Font Programs") to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols ("Typefaces") solely for your own
customary business purposes on the display window of the RIP Station or monitor used with RIP Station;
c. use the trademarks used by Electronics For Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom ("Trademarks"); and
d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to RIP Station provided the transferee agrees to be bound
by all of the terms and conditions of this Agreement.
You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces for use other than with RIP Station;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as necessary for use with the RIP Station unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, any copies of that certain portion of the Software which has been included on the RIP Station hard disk drive. You may not copy the documentation;

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics For Imaging and its suppliers and that title and other intellectual property rights therein remain with Electronics For Imaging and its suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or trade name which is likely to be similar to or confusing with that of Electronics For Imaging or any of its suppliers or take any other action which impairs or reduces the trademark rights of Electronics For Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font Programs. At the reasonable request of Electronics For Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic termination of this license and will make available to Electronics For Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics For Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without significant errors that make it unusable. Electronics For Imaging's entire liability and your exclusive remedy under this warranty (which is subject to you returning RIP Station to Electronics For Imaging or an authorized dealer) will be, at Electronics For Imaging's option, to use reasonable commercial efforts to attempt to correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics For Imaging makes and you receive no warranties or conditions on the Products, express, implied, or statutory, and Electronics For Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics For Imaging does not warrant that the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK.

BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government licenses. Your failure to comply with this provision is a material breach of this Agreement.
Government Use
Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary
You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the Typefaces and the Trademarks licensed hereby. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics For Imaging.

General
This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics For Imaging, Attn.: Licensing Dept. or see Electronics For Imaging’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
## Preface

### About this manual

xi

### About the documentation

xii

Terminology and conventions

xiii

### How the RIP Station works

xiv

About PostScript printer drivers and PPDs

xiv

### Before you begin

xv

## Chapter 1: Using the Control Panel

### Introduction to the RIP Station Control Panel

1-1

Activity light

1-2

Buttons

1-2

Display window

1-3

Functions menu

1-4

### Starting and shutting down the RIP Station

1-6

Starting the RIP Station

1-6

Restarting the RIP Station

1-7

Shutting down the RIP Station

1-7

## Chapter 2: Printing from Windows Computers

### Printing from applications

2-1

Setting options and printing from Windows 95/98

2-1

Working with custom page sizes in Windows 95/98

2-12

Setting options and printing from Windows NT 4.0

2-14

Setting options and printing from Windows 2000

2-18

Working with custom page sizes in Windows 2000

2-21

Printing to the parallel port

2-23

Saving files to print at a remote location

2-24

### Using Fiery Downloader to print

2-25
Chapter 3: Printing from Mac OS Computers

Printing from applications 3-1
Selecting the RIP Station in the Chooser 3-1
Setting options and printing from Mac OS computers 3-3
Defining custom page sizes 3-5

Printing with Fiery Downloader 3-7

Chapter 4: Printing from UNIX Workstations

Printing to the RIP Station 4-1

Chapter 5: Downloading Files and Fonts

Using Fiery Downloader 5-1
Printing with Fiery Downloader 5-4
Downloading and managing printer fonts 5-8

Chapter 6: Tracking and Managing Print Jobs

Tools for job tracking and management 6-1
Fiery WebTools 6-1
Fiery Spooler 6-1

Fiery WebTools 6-2
Access privileges 6-3
Checking RIP Station status with the Status WebTool 6-5
Accessing information with the WebLink WebTool 6-6
Using the Print Monitor 6-6
Appendix A: Print Options

Where to set print options A-1
Print options and override hierarchy A-2
Default settings A-2
More information about print options A-9

Appendix B: Font List

Printer fonts B-1
Adobe Type 1 fonts B-1
TrueType fonts B-5
Appendix C: Troubleshooting

Error messages C-1
Maintaining optimal system performance C-2
Troubleshooting C-2
  General printing problems C-3
  Problems with print quality C-5
  Problems with Fiery Spooler C-7
  Problems with Fiery Downloader C-7
  Problems with Fiery WebTools C-8

Index
The RIP Station 5100 Series II™ enables you to use your color printer as a networked printer. You can use the RIP Station 5100 Series II to print final documents or to proof jobs you will later print on an offset press. You send a print job to the RIP Station as you would to any other printer—you select it from the Windows Printers dialog box or Mac OS Chooser, and then print from within any application.

**NOTE:** The term “RIP Station” is used in this manual to refer to the RIP Station 5100 Series II.

### About this manual

This manual covers the following topics:

- Using the RIP Station Control Panel
- Printing from a Windows computer
- Printing from a Mac OS computer
- Printing from UNIX workstations
- Downloading files and fonts using Fiery Downloader™
- Tracking and managing jobs and accessing information using Fiery WebTools™ and Fiery client utilities
- Specifying and overriding job settings, a list of the printer fonts installed on the RIP Station, and troubleshooting information
About the documentation

This manual is part of a set of RIP Station documentation that includes the following manuals for users and system administrators:

- The Administrator Guide explains basic configuration and administration of the RIP Station for the supported platforms and network environments. It also includes guidelines for setting up UNIX, Windows NT, and Novell NetWare servers to provide Adobe PostScript printing services to clients.

- The Setup Guide describes how to install software to enable users to print to the RIP Station. Specifically, it describes installation of PostScript printer drivers, printer description files, and other user software provided on the RIP Station User Software CD. It also explains how to connect each user to the network or the parallel port.

- The User Guide describes the printing features of the RIP Station for users who send jobs via remote workstations on the network or via a direct parallel port connection. It also explains how to use the Fiery WebTools and RIP Station client utilities to manage jobs and provides troubleshooting information for problems that may arise.

- The Color Guide provides information on managing the color output of your RIP Station. It addresses concepts and issues associated with printing to the RIP Station and outlines key workflow scenarios. This manual explains how to take advantage of the ColorWise® color management system, as well as features of ColorWise Pro Tools™. In addition, the Color Guide offers information on printing from popular Windows and Mac OS applications.

- Release Notes provide last-minute product information and workarounds for some of the problems you may encounter.
Terminology and conventions

Specific terms are explained as they are introduced. However, the following general terms are used throughout:

- **PostScript (PS)**—A computer language designed as a page description language. The RIP Station uses this language for imaging the page and for communication with applications and with the print engine.

- **Job**—A file consisting of PostScript commands and comments that describe the graphics, sampled images, and text that should appear on each page of a document, and the printer options that should be used in printing, such as media or color rendering style.

- **Spool**—Write to a disk. Usually used here to refer to a PostScript print job being saved to the RIP Station hard disk in preparation for processing and printing.

- **RIP**—Acronym for raster image processing, which changes text and graphics commands into descriptions of each mark on a page. In common use as a noun, a “raster image processor” (RIP) is the computer process that performs this function.

- **Print**—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the RIP Station and the printer work together as a powerful printing system. The RIP Station changes text and graphics commands in PostScript into color specifications for each dot of ink deposited on a page by the printer.
How the RIP Station works

The RIP Station receives files from computers on the network, processes (RIPS) those files, and then sends them to the printer’s print engine for printing.

When printing from an application, your Windows or Mac OS computer communicates with the RIP Station by means of a PostScript printer driver and a PostScript printer description file (PPD).

About PostScript printer drivers and PPDs

A PostScript printer driver is an application that manages printing communication between your application software and the printer. It interprets the instructions generated by the application software, merges those instructions with printer-specific PPD options you specify (see below), and translates all that information into PostScript, a language the printer understands. In other words, the printer driver writes a PostScript file based on your original file and the options you set from the Print dialog box.

A PPD file contains information about a particular device’s features and capabilities (for example, what paper sizes and media types are supported). The PostScript printer driver reads the information in the PPD file and presents that information to you in the form of options you can choose from the Print dialog box. The PPD for the RIP Station includes information about the features of both the printer and the RIP Station 5100 Series II.

For information on the PPD options for your RIP Station, see Appendix A, "Print Options."
Before you begin

Before using the RIP Station, follow these steps:

1. **Confirm that the system administrator has completed Setup as described in the Administrator Guide.**

2. **Find out what printer defaults the administrator specified in Setup.**
   - These default settings can affect the results of your print jobs. Check with your administrator or operator for information on these default settings.

3. **Confirm that the user software is installed correctly on your workstation, as described in the Setup Guide.**

4. **Consult the Color Guide for information on print options and application features that affect color output.**

5. **Find out how your workstation is configured for printing on the network.**
   - If your site has an operator who controls all printing, you may have access to the Hold queue only. In this case, all jobs you send are spooled to the RIP Station and held until the operator sends them to their next stage of processing.
   - You may also have access to the Print queue. If you send jobs to this queue, jobs spool to the RIP Station and proceed to RIP and print according to your job settings—unless someone (you, or an operator, for example) intervenes.
   - Lastly, you may have access to the Direct connection, which sends jobs straight to the server without spooling.

6. **Find out whether the RIP Station is set up to use Fiery WebTools and what your access privileges are.**
   - The administrator may or may not have enabled access to the server via the Internet (or an intranet). If access is enabled, a password may be required to perform job management with Fiery WebSpooler.
You can use the RIP Station Control Panel to view status information, print special pages, and set up printing.

Introduction to the RIP Station Control Panel

The Control Panel, shown below, comprises the following parts:
**Activity light**

The activity light indicates current RIP Station activity. If the light is:

- **Solid red**: An error has occurred causing the RIP Station to be disabled.
- **Flashing red**: There is an error causing printing to be disabled, but the RIP Station is capable of processing.
- **Solid green**: The RIP Station is idle.
- **Flashing green**: The RIP Station is processing or printing a job, or communicating with a remote computer.
- **No light**: The RIP Station is off or starting up.

**Buttons**

- **Line selection buttons**: There are four line selection buttons on the right side of the Control Panel. Use these buttons to select the command displayed on the corresponding line of the display window. When a button is active, a special character (>) appears in the display window next to the button.
- **Up and down button**: Press this button to scroll to different screens in multi-screen lists, to select Setup options from a list of available options, and to scroll alphanumeric characters.
- **Menu button**: Press to view other screens. Under normal operation, the Control Panel displays the Idle, RIP, or Print Status screens with information about the status of the RIP Station. If you press the Menu button, the Functions menu is displayed and you can perform additional operations (see page 1-4). If a job is processing or printing, press the Menu button to cycle among the active screens.
Display window

The display window provides information about the status of the RIP Station, displays menu information, and enables you to view and edit information in the Setup menus.

The last line of the display window displays text that tells you what screen you are looking at and highlights one of the icons to indicate what the RIP Station is doing. Only the icons for the screens that are currently available appear. The menu button cycles among the active screens as follows:

Alert Status
If there is a problem with processing a job or printing functions, an error message appears on the Control Panel.

Print Status
When the RIP Station is printing a job, the Print Status screen appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job currently printing.

User name—The name of the user who sent the job currently printing.

Pages/Total—The number of copies of the current job printed and the total number of copies of the job requested.

RIP Status
When the RIP Station is processing a job, the RIP Status screen appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job currently processing. The RIP Station cancels the job before printing begins.

Document name—The name of the document currently processing.

User name—The name of the user who sent the job currently processing.

Kilobytes—The size (in kilobytes) of the job processed so far.

Note: This number is always displayed in kilobytes, even if the amount goes over 1000KB; for example, 10MB is displayed as 10000KB.
Info Status

When the RIP Station is not processing or printing a job, it displays the following information about the current server and software:

Server Name—The RIP Station name.

Status—The current status of the RIP Station. The RIP Station status can be: Idle, Initializing, Busy, Processing, or Printing.

Megabytes—The space (in megabytes) available on the RIP Station hard disk, for example, 756MB.

Version—The system software version running on the RIP Station.

Functions

You can press the Menu button to display the Functions menu. Use the up and down button to scroll through the list. Press the line selection button to the right of a command to select that command. See “Functions menu” for more information.

Network

The network icon appears at the bottom left of any of the other screens when a job is being sent to the RIP Station, either over the network or through the parallel port. The network icon also appears, together with a flashing green activity light, when a remote utility is running.

Functions menu

Print Pages

Print special pages from the RIP Station. You can print the following pages from the submenu that appears:

Test Page—A Test Page enables you to confirm that the RIP Station is properly connected to the printer, and provides color and grayscale samples to troubleshoot problems with the printer or the RIP Station. The following settings are among those listed on the Test Page: Server Name, Printer Model, calibration information, date and time the Test Page was printed, and default color settings.
Introduction to the RIP Station Control Panel

Configuration—Prints the Configuration page, which gives the current server and device configuration. This page lists general information about the hardware and software configuration of the RIP Station, the current options for all Setup settings, information about the current calibration, and the Ethernet addresses of the RIP Station.

Job Log—Prints a log of the last 55 jobs. For information on the fields in the Job Log and on printing it in other forms, see Chapter 6, "Tracking and Managing Print Jobs."

Control Panel Map—Prints the Control Panel Map, which is an overview of the Setup and other function screens you can access from the Control Panel. For information about using these screens to set up the RIP Station, see the Administrator Guide.

Color Charts—Prints samples of the RGB, CMY, and PANTONE colors available from the RIP Station.

Font List—Prints a list of all fonts currently on the RIP Station hard disk.

Reboot Server

Shut down all RIP Station activity in the correct manner and then restart. You should use this option instead of the power switch on the back of the RIP Station.
Starting and shutting down the RIP Station

Generally, you can leave the RIP Station running all the time. This section describes how to shut down and restart the RIP Station when necessary.

Starting the RIP Station

To start the RIP Station, move the power switch on the back of the RIP Station to the On position. If the printer is also powered off, power it on before powering on the RIP Station.

Diagnostic messages appear on the Control Panel. If any diagnostics fail, more information and instructions appear. Contact your service representative if the RIP Station encounters problems while running the diagnostics.

When the diagnostics are finished, the following message is displayed:

For software update or setup, press any key

To change Setup option settings, press any button while the For software update or setup, press any key message is displayed. For more information about Setup menus and options, see the Administrator Guide.

If you do not press a button, the RIP Station continues starting up and displays the message Idle when it is ready to receive data.

**NOTE:** If you entered the Start Up menus in error, choose the Start System menu option to exit Start Up menus.
Restarting the RIP Station

You should use the procedure described below to restart the RIP Station rather than using the power switch.

**NOTE:** You must restart the RIP Station in order to access Setup options.

**To restart the RIP Station:**

1. Make sure that the RIP Station is not receiving, processing, or printing a job.
   The status message on the Control Panel should read **Idle**.
   
   **NOTE:** If a job from the Print queue is processing, it will continue processing and print after the RIP Station is restarted; if a job sent to the Direct connection is processing, it will not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the up and down button to scroll to the last screen and choose **Reboot Server**.

Shutting down the RIP Station

You may need to shut down the RIP Station for service. When you do so, fonts that have been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and Printed queues and jobs that have been processed but not printed are not deleted and are available for printing when you restart the RIP Station.

**To shut down the RIP Station:**

1. Make sure that the RIP Station is not receiving, processing, or printing a job.
   Make sure that the status message on the Control Panel is **Idle**. If a job has just finished processing or printing, wait at least five seconds after the status message switches to **Idle** before proceeding to step 2.
   
   **NOTE:** If a job from the Print queue is processing, it will continue processing and print after the RIP Station is restarted; if a job to the Direct connection is processing, it will not finish processing or printing.

2. Power off the RIP Station by moving the power switch on the back to the Off position.
This chapter describes how to print to the RIP Station from Windows 95/98, Windows NT 4.0, and Windows 2000 computers.

You can print from a networked Windows computer, from a Windows computer using Windows (WINS) printing, or from a Windows computer connected to the parallel port on the RIP Station. If you plan to print files at another location, follow the procedures described in “Saving files to print at a remote location” on page 2-24.

Another way to print from a Windows 95/98, Windows NT 4.0, or Windows 2000 computer is to download TIFF images, PostScript, Encapsulated PostScript (EPS), or Portable Document Format (PDF) files using Fiery Downloader. Basic instructions are provided at the end of this chapter; for details on using Fiery Downloader, see Chapter 5.

**NOTE:** For information on setting up the Windows environment for printing with Windows servers connected to the RIP Station, see the *Administrator Guide*. For information on how to connect to the RIP Station over the network, install printer drivers, and install Fiery Downloader, see the *Setup Guide*.

**Printing from applications**

Once you have installed the printer driver and set it to the proper port as described in the *Setup Guide*, you can print directly from most Windows applications. Simply choose the Print command from within your application.

To achieve the best printing results from specific applications, see the *Color Guide*.

**Setting options and printing from Windows 95/98**

To print from Windows 95/98, use the Adobe PostScript printer driver for Windows 95/98. The driver is included with the RIP Station user software.

Once you have installed the Adobe PostScript printer driver and the PPD file, you can specify print settings for a particular job and print it to the RIP Station.
To print from Windows 95/98 applications by connecting your computer to a print server via the network, one of the following is required: a NetWare server, a Windows NT server, or a UNIX server. For more information, see the Administrator Guide.

To print from Windows 95/98 applications without connecting to a print server, you can use SMB printing. For more information, see the Setup Guide.

**To set print options and print from Windows 95/98 using the Adobe PostScript printer driver:**

1. Click the Start button, point to Settings, and click Printers.
2. Select the icon for the RIP Station and choose Properties from the File menu.
3. Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions.
4. Click the ColorWise print option bar.

Specify the Print Mode, Brightness, and Combine Separations options for the job.
If you want to use advanced color management features (such as Rendering Style), proceed to step 5, otherwise skip to step 8.

5. Click Expert Settings.

6. Click Update to display the current RIP Station settings.
If the Update button does not appear, make sure that Two-Way communication is set up as described in the Setup Guide.
7. Specify the color settings for the print job, and click OK.

8. Click the Job, Media, Layout, Watermarks, and Image Quality print option bars to specify the appropriate settings for the print job.

These print options are specific to the RIP Station and the printer. They override settings specified in RIP Station Printer Setup, but can be overridden from the Fiery WebSpooler or Fiery Spooler. For information about these options and overrides, see “Print options and override hierarchy” on page A-2.

If you choose Printer's default, the job prints according to the settings entered during Setup, or the default settings. See “Default settings” on page A-2 for more information.

**NOTE:** If you specify incompatible print settings, the Conflict dialog box may appear. Follow the on-screen instructions to resolve the conflict.

9. Click the Owner Information print option bar.

10. Enter text messages in the Notes 1 and Notes 2 areas.

Enter user and job identification information for accounting purposes, or whatever information is required at your site.

The information you enter in these areas appears in the Job Log. It cannot be edited or erased by the operator.
11. **In the Instructions area, enter instructions to the operator about the job.**
   The information you enter in this area can be viewed in the Fiery WebSpooler and Fiery Spooler Override Print Settings dialog box, but does not appear in the Job Log. These instructions can be edited by the operator.

12. **Click OK.**

**Using saved settings**
Print option settings can be saved on your hard disk so you can easily load specifically configured settings for a particular job. Settings files can also be shared over a network, using the Import and Export features.

**To create saved settings:**

1. Make sure that Default Settings appears in the Saved Settings pop-up menu, then configure the options from all the print option bars.

   ![Saved Settings menu](image)

   As soon as you change any settings, the Saved Settings menu displays **Untitled** instead of **Default Settings**.
2. Click the Disk button.

![Click the Disk button](image)

3. Enter a Settings Name and click OK.

![Save Settings](image)

The name appears in the Saved Settings pop-up menu.

---

**To load saved settings:**

1. From the Fiery Printing tab, click the Saved Settings pop-up menu.

2. Choose the settings you want to use.

   The options are automatically configured with the saved settings.
TO DELETE SAVED SETTINGS:

1. From the Fiery Printing tab, click the Settings button.

2. Select the settings you want to delete and click Delete.

3. Click Yes to confirm deletion, and click OK.

TO MODIFY SAVED SETTINGS:

1. From the Fiery Printing tab, click the Saved Settings pop-up menu.

2. Choose the settings you want to modify.

   The options are automatically configured with the currently saved settings.
3. Configure your new settings from the print option bars, and click the Disk button.

4. Click OK to save the modified settings.

**To Export Saved Settings:**

1. From the Fiery Printing tab, click the Settings button.

2. Select the Saved Settings you want to export, and click Export.
3. Browse to the location where you want to save the file, enter a file name, and click OK.

![Image of Export Saved Settings dialog box]

NOTE: The file name must include the .sav extension and can be up to eight characters long (not including the extension). The file name does not have to match the Settings Name.

4. Click OK in the Settings dialog box.

---

**To import saved settings:**

1. From the Fiery Printing tab, click the Settings button.

2. Click the Import button.

3. Browse to the location of the saved settings file you want to import.

4. Select the file, and click OK.

![Image of Import Saved Settings dialog box]
5. Click OK in the Settings dialog box.

**NOTE:** When you import saved settings, they appear in the Saved Settings menu under their Settings Name, not the file name. In the example above, the file present.sav (file name) was imported, but it appears in the Saved Settings menu as Presentation (Settings Name).

**Using Shortcuts**

The Shortcuts section of the driver interface displays the current settings for some of the most common print options. You can access and change these settings quickly and easily using the Shortcuts. You can also access some page layout and finishing options by right-clicking the image of the page directly below Shortcuts.
To set print options using shortcuts:

1. From the Fiery Printing tab, place your cursor over the print option you want to set. When your cursor is directly over the print option name, the cursor turns into a hand and the option name is underlined; see the Print Mode print option in the example below.

2. Click the selected print option and specify the appropriate settings. Alternatively, you can right-click the print option and specify the settings directly.

3. Click OK.
To set print options using the page shortcuts:

1. From the Fiery Printing tab, place your cursor over the page image and right-click.

2. Specify the appropriate settings for the print options.

3. Click OK.

Working with custom page sizes in Windows 95/98

With custom page sizes, you define the page dimensions and the unprintable area of the page. You can save three different custom page sizes for easy use any time you print.

**NOTE:** Custom page sizes are not available from Windows NT 4.0.

To define a custom page size:

1. Click the Start button, point to Settings, and choose Printers.

2. Right-click the RIP Station icon, and choose Properties.

3. Click the Fiery Printing tab, and click the Job print option bar.
4. Click the Custom button.

5. Enter the name and the dimensions of the page, and click OK.

The new custom page name appears in the Page Size pop-up menu.

6. To define the unprintable area of the custom page, click the Unprintable Area button, enter the desired information, and click OK.

7. Click OK.

After you define a custom page size, you can use it from within an application, without having redefine it each time you print.
To print a custom page size:

1. Choose Print from your application.
2. Make sure the RIP Station is selected as the printer, and click Properties.
3. Click the Fiery Printing tab, and click the Job print option bar.
4. Select the custom page size from the Page Size pop-up menu.

Setting options and printing from Windows NT 4.0

You can print from Windows NT 4.0 using the Adobe PostScript printer driver included on the User Software CD.

Once you have installed the Adobe PostScript printer driver and the PPD file, you can specify print options.

You can set options on a job-by-job basis (see below), or establish default settings for all jobs printed from your computer to the RIP Station (see page 2-17).

To print from Windows NT 4.0 applications by connecting your computer to a print server via the network, one of the following is required: a NetWare server, a Windows NT server, or a UNIX server. For more information, see the Administrator Guide.

To print from Windows NT 4.0 applications without connecting to a print server, you can use SMB printing. For more information, see the Setup Guide.
To set print options for a specific Windows NT 4.0 print job using the AdobePS printer driver:

1. Choose Print in your application.

2. Make sure the RIP Station is selected as your printer and click Properties.

3. Click the Advanced tab, and select the appropriate settings for the print job.

   In the Paper Size menu, specify the page size for the job.
   In the Orientation menu, specify whether the job is printed in portrait, landscape, or rotated orientation.
   In the Copy Count menu, specify the number of copies of the print job.
4. Scroll down to Printer Features, and select the appropriate settings for the print job.

These print options are specific to the RIP Station and the printer. They override settings in RIP Station Printer Setup, but can be changed in the Properties dialog box in the Override Print Settings dialog box with Fiery Spooler or Fiery WebSpooler. For information about these options and overrides, see page A-2.

If you choose **Printer’s default**, the job prints according to the settings entered during Setup, or default settings.

**Note:** If you specify incompatible print settings, a dialog box may appear. Follow the on-screen instructions to resolve the conflict.

5. Click OK.

6. Click Print.

The job prints with the specified settings.
To set default print options for all Windows NT 4.0 jobs using the AdobePS printer driver:

1. Click the Start button, point to Settings, and click Printers.

2. Right-click to select the RIP Station and choose Document Defaults.

3. Click the Page Setup tab.

4. Specify the page setup default settings for your print jobs as described in step 3 on page 2-15.

5. Click the Advanced tab.

6. Specify the advanced default settings for your print jobs as described in step 4 on page 2-19.

7. Click OK.
Setting options and printing from Windows 2000

You can print from Windows 2000 using the Microsoft printer driver included with your Windows 2000 system.

Once you have installed the printer driver and the PPD file, you can specify print options.

To print from Windows 2000 applications by connecting your computer to a print server via the network, one of the following is required: a NetWare server, a Windows NT server, or a UNIX server. For more information, see the Administrator Guide.

To print from Windows 2000 applications without connecting to a print server, you can use SMB printing. For more information, see the Setup Guide.

To set print options and print from Windows 2000 print job using the Microsoft printer driver:

1. Choose Print in your application.

   Depending on the application, you’ll see one of two dialog boxes.

2. Select the RIP Station, and set print options for the job by clicking Properties (if necessary) and the print option tabs.
3. Click the Advanced button on the Layout or Paper/Quality tab to display the Advanced Options dialog box.

   ![Advanced Options dialog box]

Select a setting from the Paper Size pop-up menu.

4. Scroll down to Printer Features, and select the appropriate settings for the print job.

   ![Printer Features settings]
These print options are specific to the RIP Station and the printer. They override settings in RIP Station Printer Setup, but can be changed using Fiery Spooler or Fiery WebSpooler. For information about these options and overrides, see page A-2.

If you choose Printer’s default, the job prints according to the settings entered during Setup, or default settings.

**NOTE:** As you select print options, incompatible print settings appear with a caution icon next to their names. If you specify incompatible print settings the Incompatible Print Settings dialog box appears. Follow the on-screen instructions to resolve the conflict.

5. **Click OK.**

Depending on the application, you’ll see one of two dialog boxes.

![Print dialog box](image)

6. **Click OK, then OK again to print, or if the Print button is available, click Print.**

The job prints with the specified settings.
Working with custom page sizes in Windows 2000

With a custom page size, you define the page dimensions and the unprintable area of the page. You can save a custom page size for easy use any time you print.

To define a custom page size:

1. Click the Start button, point to Settings, and choose Printers.
2. Right-click the RIP Station icon, and choose Printing Preferences.
3. Click the Advanced button.

4. Select PostScript Custom Page Size from the Paper Size pop-up menu.

5. In the PostScript Custom Page Size Definition dialog box, specify options to define the custom page size.
Custom Page Size Dimensions—Specify the width and height of the print job.
Unit—Specify the unit of measurement for the print job.
Paper Feed Direction—Specify the paper feed direction of the print job.
Paper Type—Specify the type of paper for the print job.
Offsets Relative to Paper Feed Direction—Specify the offsets (margins) of the print job relative to the paper feed direction.

6. Click OK to close the Advanced Options dialog box.
7. Click OK to close the Printing Preferences dialog box.

After you define a custom page size, you can specify it from within an application, without having redefine it each time you print.

To print a custom page size:

1. Choose Print from your application.
2. Right-click the RIP Station icon, and choose Printing Preferences.
3. Click the Advanced button.
4. Select PostScript Custom Page Size from the Paper Size pop-up menu.
5. Verify the custom page size settings. Click OK.
6. Click OK to close the Advanced Options dialog box.
7. Click OK to close the Printing Preferences dialog box.
8. Click Print.

Printing to the parallel port

The RIP Station has a parallel port that enables you to print most files directly from a Windows computer if your network administrator has connected the Windows computer's parallel port to the RIP Station parallel port.

Note: You cannot use Fiery Downloader to print to the parallel port.
To print files to the parallel port:

1. **Make sure the parallel port is enabled on your RIP Station.**
   Check with your site administrator or operator to see whether printing to the parallel port is enabled. See Setup Guide for information on setting up parallel port printing on your Windows computer.

2. **Select the printer port that is connected to the RIP Station parallel port.**
   Select one of the local ports: LPT1, LPT2, or LPT3. For instructions, see your Windows documentation.

3. **Print from within your application.**
   If you are printing a PostScript file in binary format (not ASCII), verify that the Network Setup option Ignore EOF Character is set to Yes. Check with your site administrator for this information.

**Saving files to print at a remote location**

If you do not have a RIP Station and are preparing files to take to a service bureau or other location, print your final files to the File port (as opposed to one of the local ports). You can also print to the File port to create a file to be downloaded using Fiery Downloader. For instructions, see your Windows documentation.
Using Fiery Downloader to print

Downloading files with Fiery Downloader is generally faster than printing from application software. You can use Fiery Downloader to print TIFF images, PostScript, EPS, or PDF files.

**To print using Fiery Downloader:**

1. **Create a TIFF image, PostScript, EPS, or PDF file. Specify the appropriate print options and include (embed) any necessary fonts that are not resident on the RIP Station.**
   
   For information on the fonts resident on the RIP Station, check with the operator. Also see Appendix B, “Font List.”

2. **Launch Fiery Downloader and connect to the RIP Station.**

   For instructions on setting up Fiery Downloader, see the *Setup Guide*.

3. **Select the file(s) you want to download, and specify any necessary options.**

4. **Click Download File(s).**

   For details, see Chapter 5, “Downloading Files and Fonts.”
You can print to the RIP Station just as you would print to any other printer. First, select the RIP Station as the current printer in the Chooser, and then print the file from within your application.

Another way to print from Mac OS computers is to download TIFF images, PostScript, EPS, or PDF files using Fiery Downloader. Basic instructions are provided at the end of this chapter; for details on using Fiery Downloader, see Chapter 5.

**Printing from applications**

Before you can print to the RIP Station from applications, you must select the RIP Station in the Chooser. Then, using the AdobePS 8.6 printer driver and the correct PostScript Printer Description file (PPD), you can control many RIP Station printing features by specifying job settings from print dialog boxes.

For information on achieving the best printing results from specific applications, see the *Color Guide*.

**Selecting the RIP Station in the Chooser**

Before you print a job, make sure the RIP Station is the currently selected printer.

---

**To select the RIP Station as the current printer:**

1. Make sure the RIP Station is connected to your network and turned on.
2. Select Chooser from the Apple menu.
   
   **Note:** Make sure AppleTalk is set to Active.
3. Click the AdobePS 8.6 icon.
   
   The RIP Station appears in the Select a PostScript Printer list in the form of `<Server Name>_<Device Name>_<Print Connection>`. The device name is the internal name of your printer.
**NOTE:** Only the print connections (Direct, Print, or Hold) that have been enabled in Setup appear in the Chooser. See the *Administrator Guide* for more information on enabling printer connections.

4. Select the RIP Station from the “Select a PostScript Printer” list.

5. Close the Chooser window.

   The RIP Station remains the current printer until you select a new printer in the Chooser.
Setting options and printing from Mac OS computers

In Mac OS applications, print options are set from both the Page Setup dialog box and the Print dialog box. For details on specific print options, see “Print options and override hierarchy” on page A-2.

**Note:** Some default print options are set by the administrator during Setup. See “Default settings” on page A-2 for more information.

**To set print options and print with the AdobePS printer driver:**

1. Open a file and choose Page Setup from the application’s File menu.

2. In the dialog box that appears, specify the Page Attributes settings for your print job.

   Make sure to select the RIP Station as your printer.

   ![Page Setup dialog box](image)

   **Note:** Page Setup dialog boxes vary across applications.

3. Click OK.
4. **Choose Print from the application’s File menu.**

Make sure the RIP Station is selected as your printer and specify settings for the print options displayed.

![Print dialog box](image)

**NOTE:** Print dialog boxes vary across applications.

5. **Go to Job Notes.**

![Job Notes dialog box](image)

In the **Notes 1** and **Notes 2** areas, enter user and job identification information for accounting purposes, or whatever information is required at your site. These notes will appear in the Job Log.
6. Go to Printer Specific Options and specify the appropriate settings for your print job.

![Printer Specific Options from the pop-up menu]

These print options are specific to the RIP Station and the printer (you may need to scroll to see all the options). They override settings in RIP Station Setup, but can be changed from the Command WorkStation, or from the Fiery WebSpooler or Fiery Spooler. For information about these options and overrides, see “Print options and override hierarchy” on page A-2.

If you choose **Printer's default**, the job prints according to the settings entered during Setup, or the default settings. See “Default settings” on page A-2 for more information.

**NOTE:** If you specify incompatible print settings, a dialog box may appear. Follow the on-screen instructions to resolve the conflict.

7. If you want to make the new settings the default settings, click Save Settings.

8. Click Print.

**NOTE:** The RIP Station does not support printing the Cover Page from the AdobePS printer driver.

**Defining custom page sizes**

With custom page sizes, you define the page dimensions and margins. After you define a custom page size, you can use it from within an application, without having redefine it each time you print.
To define a custom page size:

1. Choose Page Setup from the application’s File menu.
2. For Paper, choose Custom.
4. Enter the page dimensions and margins.
   You can view the minimum and maximum sizes by using the pull-down menu under PPD Limits.
5. To save this custom page size, enter a name for it and click Add.
   Saved custom page sizes appear in the menu of page sizes at the top right of the dialog box. To remove a saved custom page size, select it from the menu and click Remove.
6. Click OK.
Printing with Fiery Downloader

Downloading files with Fiery Downloader is generally faster than printing from application software. You can use Fiery Downloader to print TIFF images, PostScript, EPS, or PDF files.

To print using Fiery Downloader:

1. Create a TIFF, PostScript, EPS, or PDF file. Specify the appropriate print options and include (embed) any necessary fonts that are not resident on the RIP Station.
   For a list of fonts resident on the RIP Station, check with the operator or see Appendix B, “Font List.”

2. Launch Fiery Downloader and connect to the RIP Station.
   For instructions on installing and setting up Fiery Downloader, see the Setup Guide.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download.
   For details, see Chapter 5, “Downloading Files and Fonts.”
You can print to the RIP Station directly from UNIX. Jobs printed to the RIP Station are sent to the Print queue or Hold queue and can be manipulated from Windows and Mac OS computers on the network using the Fiery Spooler or Fiery WebSpooler.

**NOTE:** If you print to the Hold queue, an operator must intervene from Fiery Spooler or Fiery WebSpooler for the job to print; jobs sent to the Hold queue are spooled to disk and held.

The queue name and RIP Station printer name are established by your system administrator. Contact your system administrator for the names of your queues.

For information about setting up printing from TCP/IP, see your UNIX system documentation.

**Printing to the RIP Station**

You can use UNIX commands to print PostScript files and text files to the RIP Station. In general, the basic print commands (lpr, lpq, lprm) can be used to send print jobs to a RIP Station. See your UNIX manual or other documentation for information about UNIX commands.

**NOTE:** Only PostScript or text file formats can be printed from UNIX.

**To print from UNIX:**

- On a system running SunOS 4.1.x or another BSD-based variant, use the lpr command to send a job to the RIP Station as follows:

  `lpr -Pprinter -#copies filename`

  For example, if the Print queue of your RIP Station is named print_Server, your file is named Sample, and you want to print two copies, type:

  `lpr -Pprint_Server -#2 Sample`
On a system running Solaris 2.x or any System V implementation of UNIX, use the `lp` command to send a job to the RIP Station as follows:

```
lp -d <printername> {-n <-#copies>} <filename>
```

For example, if the Print queue of your RIP Station is named `print_Server`, your file is named `Sample`, and you want to print two copies, type:

```
lp -d print_Server -n 2 Sample
```

**To display a list of jobs in the queue:**

- On a system running SunOS 4.1.x or another BSD-based variant, use the `lpq` command to see printer jobs in the queue as follows:

```
lpq <-Pprinter>
```

For example, if the Print queue of your RIP Station is named `print_Server`, type:

```
lpq -Pprint_Server
```

Your workstation displays the contents of the queue.

- On a system running Solaris 2.x or any System V implementation of UNIX, use the `lpstat` command to see printer jobs in the queue as follows:

```
lpstat -o <printername>
```

For example, if the Print queue of your RIP Station is named `print_Server`, type:

```
lpstat -o print_Server
```

Your workstation displays the contents of the queue.
To remove jobs from the queue:

**Note:** Unless you log in as the root user, you can remove only your own jobs.

- **On a system running SunOS 4.1.x or another BSD-based variant, use the lprm command to remove jobs from the queue as follows.**

  `lprm -P<printer> <job #...>`

  You can use the `lpq` command to check the job number.

  For example, to remove job number 123 from the Print queue of your RIP Station named `print_Server`, type:

  `lprm -Pprint_Server 123`

  The `lprm` command reports the names of any files it removes.

- **On a system running Solaris 2.x or any System V implementation of UNIX, use the cancel command to remove jobs from the queue.**

  `cancel <printename> <job ID>`

  For example, to remove job number 123 from the Print queue of your RIP Station named `print_Server`, type:

  `cancel print_Server 123`
Fiery Downloader allows you to send TIFF, PostScript, Encapsulated PostScript (EPS), and Portable Document Format (PDF) files directly to the RIP Station without using the application in which they were created. It also enables you to manage printer fonts on the RIP Station.

You can use Fiery Downloader from a remote workstation as well as from the Command WorkStation. Fiery Downloader requires a network connection. For information on installing and configuring Fiery Downloader and on supported networking protocols, see the Setup Guide.

**NOTE:** The Windows and Mac OS versions of Fiery Downloader are fundamentally the same; differences are noted in this section. Where both windows or dialog boxes are illustrated, the Windows version comes first, followed by the Mac OS version.

**Using Fiery Downloader**

You can use Fiery Downloader to:

- Print TIFF, PostScript, EPS, and PDF files to the RIP Station
- Check the status of the RIP Station
- Manage the PostScript printer fonts stored on the RIP Station hard disk (this feature requires that the Direct connection is published on the RIP Station)

**NOTE:** Fiery Downloader was designed specifically for the RIP Station; you cannot use it with any other printer. You can also use standard LaserWriter downloaders, such as the Adobe Font Downloader, with the RIP Station.
To view information with Fiery Downloader:

1. On Windows, choose Fiery Downloader from the Start>Programs menu.
   On Mac OS, double-click the Fiery Downloader icon.

2. On Windows, select the RIP Station in the Choose Printer Device window, and click OK.
   On Mac OS, select the RIP Station in the Chooser window, and click Connect.

The Fiery Downloader Status window appears and you see the Fiery Downloader Toolbar, menus, and the status bar at the bottom of the screen.

Displays server status and user and document name of the job currently printing

Displays server status and user and document name of the job currently processing

Dynamically displays the progress of the job

Displays the amount of available disk space
Buttons for some menu functions appear in the Toolbar at the top of the window.

- **Open**  
  Click to connect to a different RIP Station.

- **Download**  
  Click to download a file or font to the RIP Station.

- **Status**  
  If you are viewing the font list, click to display the status window for the current RIP Station.

- **Font list**  
  If you are viewing the status window, click to display a list of printer fonts on the RIP Station hard disk.

- **About Fiery Downloader**  
  Click to view version information about Fiery Downloader. (Windows only)

You can click the font list button or choose Font List from the File menu to view font information in the window.

3. **To select a different RIP Station, choose Open from the File menu or click the Open button.**

4. **Select the RIP Station in the dialog box that appears, and click OK (Windows) or Connect (Mac OS).**

5. **To close the status window, choose Close from the File menu; to quit Fiery Downloader, choose Exit (Windows) or Quit (Mac OS) from the File menu.**
Printing with Fiery Downloader

Printing files with Fiery Downloader is fast—generally faster than printing from within applications. If you regularly print large files, be sure to try printing with Fiery Downloader.

**To download a file or font with Fiery Downloader:**

1. **Use your application to generate a file.**
   You can save a TIFF, PostScript or PDF file by selecting the appropriate option in the application's Print dialog box. With some applications, you can also save EPS files.
   If you experience problems printing EPS files with Fiery Downloader, you can print the file directly from the application in which it was created.

2. **Launch Fiery Downloader.**

3. **Choose Download from the File menu or click the Download button.**
   A dialog box containing a list of files appears.
4. Choose the file type to display from the Files of type (Windows) or Show (Mac OS) menu.

You can leave this at the default All Known Formats or choose All Files. All Known Formats lists all files in formats supported by Fiery Downloader.

You can download files and fonts in the same batch. If the fonts are used by files in the same batch, the fonts should be downloaded first.

5. Choose the Connection Type (Windows) or Queue (Mac OS) to which you will download the files.

The options available to you in this menu depend on the setup at your site. The potential selections are Print Queue (Windows) or Print (Mac OS), Hold Queue (Windows) or Hold (Mac OS), and Direct Connection (Windows) or Direct (Mac OS). If your administrator has not enabled one or more of these connections, you cannot select it.

PDF files cannot be printed with the Direct connection. If you choose the Direct connection, the job is spooled to the Print queue and then printed. If the Print queue is not enabled, the job is spooled to the Hold queue and must be released for printing by the operator.

**Note:** To download fonts, you must use the Direct connection (make sure that the Direct connection is published on the RIP Station). If you do not have access to the Direct connection, you must embed any special fonts used by the file in the file when you generate it.
6. Select the filename and click Add File(s) (Windows) or Add (Mac OS).

The File name field (Windows) displays the name of the selected file before you click Add.

You can navigate to different drives and directories to select files to download. Click Add All (Mac OS) to add all files in a folder.

To select multiple sequential files, select the first file and then Shift-click the last file. Control-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to Download list and click Remove File(s) (Windows) or Remove (Mac OS).

Click Remove All (Mac OS) to remove all files from the Files to Download list.

7. To change the attributes of a file to be downloaded, select it and click Options.

NOTE: You cannot use the Options button to change the attributes of TIFF files.
8. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or leave the default settings, for each file.

Copies—Specify the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file appears to be too dark or too light. Choose 85% for a substantially lighter image, 115% for a substantially darker image, or one of the options in between.

Note: Some applications, including Adobe Photoshop, provide transfer functions that let you specify density settings for an image. If the file you are printing includes transfer functions, the Fiery Downloader Brightness option has no effect. For more information on using transfer functions, see the documentation for your application.

‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) (PostScript and EPS files only)—In most cases, you do not need to use this option. Select the ‘showpage’ option only if an EPS file fails to print without it. This option adds a ‘showpage’ PostScript language command at the end of the print job. Some applications omit this necessary PostScript language command when they generate EPS files. Select this option when printing EPS files generated by these applications. If you select this option unnecessarily, extra blank pages may print.

If you experience problems printing EPS files with Fiery Downloader, you can print the file directly from the application in which you created it.

Page range (PDF files only)—Specify the page range you want to print.

9. Click Download File(s) (Windows) or Download (Mac OS).

10. To cancel downloading, press Escape (Windows) or Command-. (Mac OS).
**Downloading and managing printer fonts**

The RIP Station includes 136 PostScript fonts; for a complete list, see Appendix B “Font List.” In addition, two Adobe Multiple Master fonts are included and are used for font substitution in PDF files.

Before downloading a file that uses fonts not resident on the RIP Station, you must download the fonts (unless the fonts are embedded in the file). To see what fonts are resident on the RIP Station, choose Font List from the File menu or click the Font List button (see page 5-10).

You can download fonts only via the Direct connection. If you do not have access to the Direct connection, you must embed any special fonts used by the file in the file when you generate it.

The screen fonts that correspond to the printer fonts installed on the RIP Station are not automatically installed on your Windows system.

**NOTE:** You cannot use Fiery Downloader to download TrueType fonts. If you use TrueType fonts in Windows, you can print them by converting them to Adobe Type 1 fonts. To do this with the Adobe PS printer driver for Windows 95/98, click the Fonts tab and set up the Font Substitution Table as necessary. For Windows NT 4.0, go to the Advanced tab of the RIP Station Document Defaults dialog box, then select Graphic>TrueType Font>Download as Softfont.

**Printer fonts and Mac OS screen fonts**

Like all PostScript fonts, the fonts included with the RIP Station come in two forms: printer fonts and screen fonts. The printer fonts are installed permanently on the RIP Station hard disk. The screen fonts, which are included with the RIP Station user software, should be installed on your Mac OS computer. If you are using these fonts in documents you print on a LaserWriter, they are probably already installed. If not, you will need to install them yourself. For instructions, see Setup Guide.
Occasionally, you may want to use Adobe Type 1 (Windows) or PostScript (Mac OS) fonts that are not included with the RIP Station. If so, you will need to install both the screen fonts and the printer fonts on your computer. To do this, follow the instructions from the font manufacturer.

**Downloading printer fonts to the RIP Station**

In general, each time you print from within a Mac OS application, the application automatically downloads any fonts used in your document that are not already installed on the RIP Station, as long as the printer fonts are installed in your System Folder. These fonts remain in the RIP Station only until your document has printed. If you print the same document again, your application must download the fonts again.

If you regularly use one or more fonts from Windows or Mac OS applications that are not already installed in the RIP Station, you can save time by downloading them to the RIP Station hard disk with Fiery Downloader. Fonts you download to the RIP Station hard disk remain installed until you remove them using Fiery Downloader, no matter how many times the RIP Station is turned off and on. You’ll probably want to download fonts you use on a regular basis to the RIP Station hard disk.

Before you download PostScript or EPS files with Fiery Downloader, make sure that all fonts included in your file are installed on the RIP Station or embedded in your file; otherwise the text in these fonts will not print correctly and may not print at all. For PDF files, font substitution occurs automatically for fonts not installed on the RIP Station. Two multiple master fonts (a serif font and a sans serif font) stored on the RIP Station are used exclusively for substitution with PDF files.
To view font information, update, print, and delete fonts:

- Choose Font List from the File menu or click the Font List button.

**NOTE:** If the Direct connection is not published, you cannot view the font list or perform any of the tasks described in this procedure. See the *Administrator Guide* or talk to your administrator for information on how to publish the Direct connection.

The Font List window appears with Update, Print, and Delete buttons in the title bar. The printer fonts included with the RIP Station (resident fonts) are locked. Locked fonts appear with a lock icon next to the name and cannot be deleted.
RIP Station user software includes a variety of tools that allow you to track and manage print jobs. The particular tools, and the access privileges for them, that are available to you depend on the conditions implemented by your site administrator. This chapter describes the functions of the Fiery WebTools and utilities that let you track and manage jobs sent to the RIP Station.

Tools for job tracking and management

Depending on the workstation you use and the setup at your site, you may be able to choose between several RIP Station job tracking and management tools.

Fiery WebTools

If your site administrator has enabled Web Services on the RIP Station, you can access Fiery WebTools from Windows 95/98, Windows NT 4.0, Windows 2000, and Mac OS computers with an Internet browser. The Fiery WebTools that provide job tracking capabilities are Fiery WebSpooler and the Status WebTool. Fiery WebSpooler also provides job management capabilities, provided you have the necessary access privileges (see page 6-3). For specific information on the browsers supported with Fiery WebTools, see the Setup Guide.

Fiery Spooler

Fiery Spooler, like Fiery WebSpooler, provides job tracking and job management capabilities. Fiery Spooler can be installed from the User Software CD on Windows 95/98, Windows NT 4.0, Windows 2000, and Mac OS client computers, and requires only a network connection to the RIP Station. If your network administrator has not enabled Web Services on the RIP Station, or if you do not have the necessary system support to use Fiery WebTools, you may choose to use Fiery Spooler for job management. For information on the system and network requirements for the Windows and Mac OS versions of Fiery Spooler, see the Setup Guide.

Note: The interface of Fiery Spooler for Windows and for Mac OS is virtually identical to that of Fiery WebSpooler; therefore, the descriptions of both are combined into one section beginning on page 6-7.
Fiery WebTools

Fiery WebTools reside on the RIP Station but can be accessed over the network from Windows 95/98, Windows NT 4.0, Windows 2000, and Mac OS client computers. The RIP Station has a home page that lets remote users view server functions and manipulate jobs. For specific information on the browsers supported with Fiery WebTools, see the Setup Guide.

The following Fiery WebTools can be accessed from the RIP Station home page.

<table>
<thead>
<tr>
<th>WebTool</th>
<th>Summary:</th>
<th>For more information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Shows you the jobs currently processing and printing.</td>
<td>See page 6-5</td>
</tr>
<tr>
<td>WebSpooler</td>
<td>Allows you to view, manipulate, reorder, reprint, and delete jobs currently spooling, processing, or printing on the RIP Station. Also allows you to view, print, and delete the Job Log. Most of these functions require a password, if one has been set.</td>
<td>See “Fiery WebSpooler, and Fiery Spooler for Mac OS and Windows” on page 6-7</td>
</tr>
<tr>
<td>WebLink</td>
<td>Provides a link to another web page, provided you have a valid Internet connection. The WebLink destination can be changed; this function requires the Administrator password, if one has been set.</td>
<td>See page 6-6 and the Administrator Guide</td>
</tr>
<tr>
<td>Installer</td>
<td>Allows you to download RIP Station printer file installers directly from the server.</td>
<td>See the Setup Guide</td>
</tr>
<tr>
<td>WebSetup</td>
<td>Allows you to modify the RIP Station configuration (Setup) remotely. This function requires the Administrator password, if one has been set. <strong>Note:</strong> WebSetup is not supported with Mac OS computers.</td>
<td>See the Administrator Guide</td>
</tr>
<tr>
<td>Print Monitor</td>
<td>Allows you to check the status of the printer’s consumables (ink and paper) from your workstation.</td>
<td>See “Using the Print Monitor” on page 6-6</td>
</tr>
</tbody>
</table>
Access privileges

The RIP Station system allows the site administrator to choose and implement a level of access and control appropriate for your particular site. The levels of access allowed to remote users depend on whether the administrator has enabled use of Fiery WebTools, and whether a password is required to use certain features of Fiery WebTools.

The levels of access to Fiery WebTools are Administrator, Operator, and Guest. To enable maximum password protection, Administrator and Operator passwords must be specified in Setup (see the Administrator Guide) for more information on setting passwords.

**NOTE:** An Operator password can be set only by using Fiery WebSetup.

When both an Administrator password and an Operator password have been specified, the access levels are as follows:

<table>
<thead>
<tr>
<th>Access level</th>
<th>Privileges and password requirements:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Has full access to all Fiery WebTools and RIP Station Control Panel functions; Administrator password required</td>
</tr>
<tr>
<td>Operator</td>
<td>Has access to all functions of Fiery WebTools <em>except</em> Fiery WebSetup and clearing the Job Log from Fiery WebSpooler; Operator password required</td>
</tr>
<tr>
<td>Guest</td>
<td>Can view job status, but cannot make changes to jobs or Setup, and cannot view the Job Log; no password required</td>
</tr>
</tbody>
</table>

If you have been given the Administrator or Operator password, you can manage job flow and override print settings of your jobs with Fiery WebSpooler. If not, you can still log in as Guest and use these tools, and the Status WebTool, to track the status of your jobs. Check with your site administrator for information on your access privileges.
To access Fiery WebTools:

1. Start up your Internet browser application.
   See the Setup Guide for information about supported platforms and browsers.

2. Enter the IP address or the DNS name of the RIP Station.
   Check with the operator or administrator for this information.

3. If the Log In dialog box appears, select a login level, enter the password, and click OK.
   The Log In dialog box appears only if the administrator has set an Administrator or Operator password.

4. When the RIP Station home page appears, click to select one of the Fiery WebTools.
   Move the cursor over the buttons to display information about the selections.

**Note:** The Configure button appears only if you logged in as Administrator. With Administrator privileges, you can click this button and specify which of the Fiery WebTools are available to other users.
Checking RIP Station status with the Status WebTool

You can use the Status WebTool to see what jobs are currently processing and printing. The Status WebTool does not require any special access privileges. If the administrator has enabled Web Services in Setup and has provided you with the IP address of the RIP Station, you can use the Status WebTool to monitor the status of print jobs as they are rasterized and printed.

To access the Status WebTool, point your browser to the RIP Station home page and click Status. The current RIP Status and Printer Status appear in the window.

To open a new browser window for the Status display, click Float. You can then close other browser windows and leave the Status window open to continue checking the status of the RIP Station. As long as you keep the Status window open, it is dynamically updated.

To obtain more information about the status of jobs, use Fiery WebSpooler or Fiery Spooler.
Accessing information with the WebLink WebTool

The WebLink button on the RIP Station home page provides a link to another web page or to multiple web pages, provided you have a valid Internet connection. The WebLink destination is initially set to www.epson.com. The administrator at your site can set the WebLink destination. Check the WebLink sites for any information available there.

Using the Print Monitor

The Print Monitor allows you to check on your printer’s consumables without leaving your desk.

To use the Print Monitor:

1. Click the Print Monitor button on the RIP Station homepage.
   The Print Monitor dialog box appears.

2. Click the Ink Status tab to check your printer’s ink ink levels.
**Fiery WebSpooler, and Fiery Spooler for Mac OS and Windows**

Fiery WebSpooler and Fiery Spooler for Mac OS and Windows provide a window on RIP Station and printer functions, and an interface from which you can control those functions.

**NOTE**: After launching, the Fiery WebSpooler and Fiery Spooler for Mac OS and Windows interfaces are virtually identical. Following the explanations of how to launch each tool, the remainder of this section uses the term “Fiery WebSpooler” to refer to both Fiery WebSpooler and Fiery Spooler for Mac OS and Windows. The interface for Fiery WebSpooler is shown; differences between Fiery WebSpooler and Fiery Spooler on Mac OS or Windows are noted.

**To Launch Fiery WebSpooler:**

- From the RIP Station home page window, click WebSpooler.

For instructions on how to access the RIP Station home page window, see page 6-4. The Fiery WebSpooler window appears in a new browser window.
To launch Fiery Spooler on a Mac OS computer:

1. Double-click the Fiery Spooler icon.

2. Select the RIP Station in the Chooser window that appears and click OK.
   
   For information on setting up the connection to the server, see the Setup Guide.

3. Select a login level, enter the password and click Log in.

   **Note:** If no password has been set, you can log in as Administrator without a password.

   The Fiery Spooler main window appears.
To launch Fiery Spooler on a Windows computer:

1. Choose Fiery Spooler from the Start>Programs menu.
2. Select the RIP Station in the Chooser window that appears.
   For information on setting up the connection to the server, see the Setup Guide.
3. Click OK.
4. Select a login level, enter the password and click Log in.
   
   **Note:** If no password has been set, you can log in as Administrator without a password.

   The Fiery Spooler main window appears.
Job management features

If you logged in to Fiery WebTools as an Administrator, or if no password was defined in RIP Station Setup, you are given full privileges which include:

• A view of current printing jobs and jobs stored on the RIP Station
• Control of printing jobs and a view of the Job Log
• Ability to clear the Job Log

If you log in to Fiery WebTools as Guest, you have the first option only. If you log in as Operator, you have the first two options. For information about Setup and specifying passwords, see the Administrator Guide.

You can use the Fiery WebSpooler to perform the following functions from your workstation:

• Override current job option settings
• Delete jobs
• Duplicate or rename jobs
• Change the priority of jobs
• Display, print, or delete the Job Log

Most of these functions require the Administrator or Operator password. However, even without a password, you can log in to Fiery WebSpooler as Guest with view-only privileges.
Job List window

Your first view of Fiery WebSpooler is the Job List window, which is divided into three areas by Spool, RIP, and Print status bars. The Job List window is surrounded by a frame that includes slider buttons and menus. System information indicators at the bottom of the window show the availability of hard disk space and RAM on the currently selected RIP Station.

When the RIP Station is receiving and processing print jobs, the Job List window is a dynamic display, filled with the names of jobs and their characteristics. Status bars animate in real time as new jobs are processed and printed, and jobs move to different display areas.

The Spool and Print areas of the Job List window represent the stages of printing a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless they are held along the way.
Tracking and Managing Print Jobs

- **Spooled jobs**—Jobs listed in the area below the Spool status bar area are PostScript files stored on the RIP Station disk. These jobs were sent to either the Print queue (white icons) or the Hold queue (yellow icons). PostScript files can come in packets from the network, or from another place on the server hard disk. Jobs are added to a queue in the order in which they arrive, and they generally move to another queue in the same order unless an operator intervenes to change the order.

- **Printed jobs**—Jobs listed in the area below the Print status bar have already been printed. Printed jobs can be stored on the RIP Station disk. The number of jobs that can be stored (from 1 to 99) is defined in Setup.

If you are logged in as Administrator or Operator, you can interact with a job wherever it appears in the window by selecting it and choosing a command from the Job menu, or by double-clicking the job and setting override options.

- **Errors**—Jobs with an error are shown in red. To display the error, double-click the job line. Note that you cannot check the job properties or hold a job with an error.

**NOTE:** If your job does not appear anywhere in the Fiery WebSpooler window, it may have already been printed; if so, it will appear in the Job Log. To view the Job Log, choose Show Job Log from the Window menu. (For more information on the Job Log, see page 6-20.)

**Menu bar**

The menu bar has five menus. When an action is not available in the current context, the command is dimmed. When a command is marked with a check, selecting it again reverses, or toggles, the command.

**Status bars**

Jobs actively involved in the three processes (spooling, rasterizing, and printing) are listed in the status bars that span the Job List window.

Status bars show the filename, number of copies and user name for the active process, and an indication of its progress. Each status bar heads the list of jobs that have completed the process. Thus, beneath the Spool status bar, you see a list of spooled files and beneath the Print status bar, you see a list of jobs that have already been printed.
## Tracking and Managing Print Jobs

<table>
<thead>
<tr>
<th>Menu:</th>
<th>Choose this:</th>
<th>To do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Print Job Log</td>
<td>Print the Job Log</td>
</tr>
<tr>
<td></td>
<td>Delete Job Log</td>
<td>Delete the Job Log</td>
</tr>
<tr>
<td></td>
<td>Export Job Log (Fiery Spooler only)</td>
<td>Save the Job Log as a text file</td>
</tr>
<tr>
<td></td>
<td>Open Fiery (Fiery Spooler only)</td>
<td>Launch Fiery Spooler for a different RIP Station</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Log out from the server and exit Fiery WebSpooler</td>
</tr>
<tr>
<td><strong>Job</strong></td>
<td>Delete Job(s)</td>
<td>Delete one or more selected jobs</td>
</tr>
<tr>
<td>(For more information on</td>
<td>Duplicate Job(s)</td>
<td>Duplicate one or more selected PostScript data jobs in the Spool or Print areas</td>
</tr>
<tr>
<td>these commands, see page</td>
<td>Rename</td>
<td>Rename a selected job</td>
</tr>
<tr>
<td>6-16)</td>
<td>Hold</td>
<td>Hold the selected job(s); see page 6-13</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Print the selected job(s)</td>
</tr>
<tr>
<td></td>
<td>Process Next</td>
<td>Give top priority to this job</td>
</tr>
<tr>
<td></td>
<td>Remove Raster</td>
<td>Remove the raster information from the selected job(s); see page 6-13</td>
</tr>
<tr>
<td></td>
<td>Override Print Settings</td>
<td>View and edit print settings for the selected job(s); see page 6-17</td>
</tr>
<tr>
<td></td>
<td>Thumbnail A</td>
<td>Open a selected held raster data job in the Thumbnail A window</td>
</tr>
<tr>
<td></td>
<td>Thumbnail B</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Delete</td>
<td>Delete the selected page(s)</td>
</tr>
<tr>
<td>(Commands for Thumbnail A)</td>
<td>Duplicate</td>
<td>Duplicate the selected page(s)</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Undo</td>
<td>Undo previous Page menu commands (multiple undos available)</td>
</tr>
<tr>
<td><strong>Window</strong></td>
<td>Show Job List</td>
<td>Show the Job List window</td>
</tr>
<tr>
<td></td>
<td>Show Job Log</td>
<td>Show the Job Log window</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>About</td>
<td>View the Fiery WebSpooler information screen</td>
</tr>
</tbody>
</table>
**NOTE:** In the Spool status bar, the filename and user information always appear as “Unknown.” This information is not available until the job has finished spooling to the RIP Station disk.

**Job icons**

There are three types of icons that are used for active jobs:

<table>
<thead>
<tr>
<th>Icon:</th>
<th>Active jobs: (white icons)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostScript icon</td>
<td>PostScript data after printing, raster deleted</td>
</tr>
<tr>
<td>Printer icon</td>
<td>PostScript or raster data headed for printing</td>
</tr>
</tbody>
</table>

**Spool area**

The job icons in the Spool area is described below:

<table>
<thead>
<tr>
<th>Spool area icon:</th>
<th>What it indicates:</th>
<th>How long you see the job:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow PostScript icon</td>
<td>PostScript data from a user on the network; no destination is defined</td>
</tr>
<tr>
<td>2</td>
<td>White printer icon</td>
<td>PostScript data headed for Print</td>
</tr>
</tbody>
</table>

The Spool area is the waiting area for jobs that will be RIPped (jobs in the Spool queue).
Print queue jobs  When printing does not require an operator, network jobs sent to the Print queue appear in the Spool area where they are shown with a white printer icon. When they reach the head of the queue, they are RIPped and printed.

Direct connection jobs  Jobs printed to the Direct connection are not displayed in the Fiery WebSpooler job lists. They are displayed briefly in the status bars (where they cannot be selected) and are included in the Job Log.

Print area
The job icon in the Print area is described below:

<table>
<thead>
<tr>
<th>Print area icon:</th>
<th>What it indicates:</th>
<th>How long you see the job:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="White PS icon" /></td>
<td>PostScript data only—raster data has been deleted</td>
<td>Until the job limit is reached</td>
</tr>
</tbody>
</table>

The Print area, also referred to as the Printed queue, contains jobs that have already been printed. These jobs were assigned to the Hold destination, (white printer icon in the Spool or RIP areas) without any hold instructions; therefore, they all have white icons.

**NOTE:** A job row that appears in light red indicates that a PostScript error occurred while printing the job. To see the error, double-click anywhere in the row.

Newly printed jobs are added to the Printed queue, and are shown at the top of the list. Jobs are saved in the Printed queue until the job limit is reached. When the first job over the limit is printed, the oldest job is deleted from the disk. The default job limit is 10 jobs. The value for Jobs Saved in Printed Queue can be changed in Setup by the administrator.

**NOTE:** If you reprint a job in the Printed queue, the job returns to its original position in the Printed queue after it is printed.

While it is printing, a job consists of PostScript and raster data; jobs with only PostScript data remaining are represented by a white PS icon.
Job commands

Using the commands in the Job menu, you can alter the destinations, priorities and other characteristics of jobs that appear in the Fiery WebSpooler window.

Job commands are used to assign a selected job to a new destination or process. These commands are available from the Job menu (see page 6-12). The job commands available at a given time depend on the context; unavailable commands are dimmed.

The job commands available for selected jobs in the Job List window are listed in the following table:

<table>
<thead>
<tr>
<th>Choose this:</th>
<th>To do this:</th>
<th>Raster data is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Job(s)</td>
<td>Delete the job(s)</td>
<td>Deleted</td>
</tr>
<tr>
<td>Duplicate Job(s)</td>
<td>Duplicate one or more selected PostScript data jobs in the Spool or Print areas. You can use the duplicate job(s) for different print options or a different destination. (The Duplicate command actually creates a reference to the original job, with the same name)</td>
<td>n/a (The Duplicate command is not available for raster jobs)</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename the job (PostScript file with or without raster)</td>
<td>Unaffected, but associated with the new name</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the renamed job is printed, the Job Log reflects the job's original name.</td>
<td></td>
</tr>
<tr>
<td>Hold</td>
<td>Hold the job in the current place (except for a job in the Print area, which is moved to the Spool or RIP area, depending on whether it still has raster data associated with it)</td>
<td>Held in RIP area, if included with job</td>
</tr>
<tr>
<td>Print</td>
<td>Print the job in its turn (RIP it first if it does not have raster data) After printing, keep the printed job in the Print area until the job limit is reached.</td>
<td>Temporarily held in RAM after printing until memory is needed for another job (If the job was printed from a held job in the RIP area, the raster data in the RIP area is kept indefinitely)</td>
</tr>
<tr>
<td>Process Next</td>
<td>Give top priority to this job Print the job (or RIP and print) as soon as the processor and copier are free, before other waiting jobs</td>
<td>Held in RAM after printing (can be selected in the Print area while it remains there), or Held in RIP area (saved to disk) if destination was RIP and Hold</td>
</tr>
</tbody>
</table>
Overriding job option settings

When logged in as Administrator, you can use the Override Print Settings command to check and override the print option settings (properties) of all jobs as follows:

- To override a setting based on printed output or other print device conditions
- To change settings for a duplicate of the original job
- To print a single copy of a job before printing the number of copies required by the user

<table>
<thead>
<tr>
<th>Choose this:</th>
<th>To do this:</th>
<th>Raster data is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Raster</td>
<td>Remove the raster from a job that has raster data; leave the PostScript job in place</td>
<td>Deleted</td>
</tr>
<tr>
<td>Override Print Settings</td>
<td>View and override print settings for a selected job or a group of selected jobs</td>
<td>Deleted and regenerated, if the newly selected options require reRIPping, or reprinted with the new settings, if none require reRIPping</td>
</tr>
<tr>
<td>Thumbnail A</td>
<td>Open the selected held raster data job in the Thumbnail A window where you can view a full-screen preview of the job, edit the job, or merge it with raster data from other jobs</td>
<td>Changed if job is edited, unaffected if job is only viewed</td>
</tr>
<tr>
<td>Thumbnail B</td>
<td>This option is not available for this release.</td>
<td>This option is not available for this release.</td>
</tr>
</tbody>
</table>

Remove Raster

Remove the raster from a job that has raster data; leave the PostScript job in place.

Thumbnail A

Open the selected held raster data job in the Thumbnail A window where you can view a full-screen preview of the job, edit the job, or merge it with raster data from other jobs.

Deleted

Override Print Settings

View and override print settings for a selected job or a group of selected jobs.

Deleted and regenerated, if the newly selected options require reRIPping, or reprinted with the new settings, if none require reRIPping.

Thumbnail B

This option is not available for this release.
TO CHANGE JOB OPTIONS:

- Double-click the job line or select the job and choose Override Print Settings from the Job menu.

If necessary, scroll down to see all the various job options.

The Override Print Settings dialog box displays all the job settings encoded by the PostScript printer driver that can be decoded by the RIP Station. If you (as operator) have not changed anything, these are the settings a user entered before sending the job.

**NOTE:** Some print options that are available in the printer driver are not displayed in the Override Print Settings dialog box.
Previewing jobs

You can preview a job in the Thumbnail A window of Fiery WebSpooler before it is printed. Set the Image Output print option to Preview to enable this feature. You can set the Image Output option to Preview either from your application when the job is printed, or from the Override Print Settings dialog box of Fiery Spooler or WebSpooler (see page 6-17).

When the Image Output option is set to Preview, the job is RIPped and then held, providing an opportunity to preview the raster data in Thumbnail A. The job is not printed until you click the Print button in the Thumbnail A window.

After jobs are printed, their raster data is discarded. For this reason, the RIP Station must reRIP a job if you want to preview a previously printed job. For more information about the RIP process and other components of the printing process, see “Job List window” on page 6-11.

The RIP Station continues to RIP and print non-preview jobs while you are previewing a job in the Thumbnail A window.

To preview a job:

1. If you are printing or reprinting a job from Fiery WebSpooler or Fiery Spooler, open the Override Print Settings dialog box for the job and set Image Output to Preview.

2. Print the job.

3. From Fiery WebSpooler, click the Thumbnail A tab at the right of the Job List window to open the slider.
After the job has been RIPped, the preview is displayed in the Thumbnail A window. The window displays the most recently previewed job, even if the job has already been printed.

4. To send the job to the printer, click the printer icon.

5. Click the Thumbnail A tab to close the thumbnail window.

**Using the Job Log**

From Fiery WebSpooler, you can view and print a log of all jobs printed by the RIP Station, including jobs downloaded with Fiery Downloader.

**NOTE:** If you logged in as Administrator, you can delete the Job Log from Fiery WebSpooler (see page 6-22). The Job Log is not available if you logged in as Guest.

**TO DISPLAY, UPDATE, PRINT, AND DELETE THE JOB LOG:**

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.

3. Click OK.

   The Job Log appears in a new browser window.
6-21Tracking and Managing Print Jobs

**NOTE:** The Delete button appears only if you logged in as Administrator.

The Job Log displays each job and the following information: status, document name, user name, date, start time, end time, process time, file size, device, paper size, media, number of originals, number of color pages, number of black-and-white pages, total number of pages, Note1, and Note2.

The Status column provides the following information about jobs:

- **OK** The job was printed normally.
- **Error** An error occurred during processing or printing.
- **Cancel** The job was canceled before printing was completed.

4. **To update the Job Log, click the Update button.**

5. **To print the Job Log, choose Print Job Log from the File menu or click the Print button.**

The information displayed in the Job Log window prints to the current RIP Station. When you print the Job Log, totals are printed for all appropriate columns.
6. If you logged in as Administrator, you can choose Delete Job Log from the File menu or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

7. To save the Job Log, choose Export Job Log from the File menu or click the Export button.

8. In the File name (Windows) or Name (Mac OS) area, enter a name for the Job Log file (the default name is Fiery Job Log.txt).

9. Browse to the location where you want to save the file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are separated by tabs.
Differences between Fiery WebSpooler and Fiery Spooler for Mac OS

Though the interfaces for both Fiery WebSpooler and Fiery Spooler for Mac OS are almost identical, there are some feature differences.

Connecting to a different RIP Station

With Fiery Spooler, you can connect to a different RIP Station from within the application using the following procedure.

To connect to a different RIP Station:

1. Choose Open Fiery from the File menu.
2. Select the RIP Station in the Chooser window that appears.
   For information on setting up the connection to the server, see the Setup Guide.
3. Click OK.
   The Fiery Spooler main window appears.
Appendix A: Print Options

Print options give you access to the special features of the printer and the RIP Station. Print options can be specified in several places—in RIP Station Setup, from the printing application, from Fiery Downloader, and from Fiery WebSpooler or Fiery Spooler. The table in this appendix briefly describes each print option, gives its default setting, and provides information on any constraints or requirements in effect.

Where to set print options

• During Setup

Some settings are specified during Setup by the administrator. To see the current default settings, print the Configuration page from the RIP Station Control Panel.

• From applications

With the Adobe PostScript printer drivers, you can specify and override job settings when you print a job. See Chapter 2, “Printing from Windows Computers” and Chapter 3, “Printing from Mac OS Computers” for information about specifying job settings from applications.

• From Fiery Downloader

Only a few settings—Page Range (for PDF files only), Copies, and Brightness (for PostScript and EPS files only)—can be specified when printing jobs with Fiery Downloader. To change options in Fiery Downloader, select the job in the Files to be Downloaded (Windows) or Files to Download (Mac OS) list and click Options. For more information, see Chapter 6, “Tracking and Managing Print Jobs”
• Overrides from Fiery WebSpooler or Fiery Spooler

To change job settings from Fiery WebSpooler or Fiery Spooler, double-click a job to display the Override Print Settings dialog box. For more information, see Chapter 6, “Tracking and Managing Print Jobs”

Print options and override hierarchy

The override hierarchy is as follows:

• A user’s printer driver settings override the RIP Station Setup and ColorWise Pro Tools settings.

• Settings made from Fiery WebSpooler or Fiery Spooler override the user's printer driver settings.

Default settings

In the following table, underlined settings in the “Options and settings” column indicate default printer driver settings (PPD defaults). In other words, if you do not use the printer driver interface to configure a particular option, the RIP Station prints the job with the underlined setting.

For options that can be configured during Setup, choosing Printer’s Default results in the RIP Station printing the job with the Setup setting specified. For options that cannot be configured during Setup, the RIP Station prints the job with a pre-configured “Printer’s default” setting. For more information, see the “Requirements, constraints, and information” column.

To find out about the current Setup defaults, print the Configuration page from the RIP Station Control Panel.
<table>
<thead>
<tr>
<th>Options and settings: (Default setting is underlined)</th>
<th>Description:</th>
<th>Requirements, constraints, and information:</th>
</tr>
</thead>
</table>
| **Auto Scale**  
*Printer’s Default/On/Off* | Select **On** to automatically scale an image up or down from its original page size to the override page size you specify. | Setting this option to **Printer’s Default** produces the same result as the **Off** setting.  
This option is available only as a Fiery Spooler or Fiery WebSpooler override.  
If this option is set to **On**, the Scale option must be set to **Printer’s Default**.  
See page A-9 for more information. |
| **Auto Sheet Cut**  
*Printer’s Default/On/Off/Off-Draw Horizontal Line* | Specifies whether the printer will automatically cut the media after printing each image. | Setting this option to **Printer’s Default** produces the same result as the **Off** setting. |
| **Bi-Directional Printing**  
*Printer’s Default/Off/On* | Specifies how ink is applied to the media. When this option is set to **On** the printer head puts ink on the selected media both when it is moving from left to right and right to left. | Setting this option to **Printer’s Default** produces the same result as the **On** setting. |
| **Brightness**  
85% Lightest/90% Lighter/95% Light/100% Normal/105% Dark/110% Darker/115% Darkest | Select **85%** for a substantially lighter image, **115%** for a substantially darker image, or use one of the settings in between. | |
| **CMYK Simulation Profile**  
Custom simulations must be defined before users select them. See page A-10 for more information. |
## Print Options

<table>
<thead>
<tr>
<th>Options and settings: (Default setting is underlined)</th>
<th>Description:</th>
<th>Requirements, constraints, and information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMYK Simulation Method</td>
<td>Select <strong>Quick</strong> to utilize one-dimensional transfer curves that adjust output density only. Select <strong>With CRD</strong> to print using the Rendering Style specified. Note: Quick option is not available when printing using Dupont paper.</td>
<td>Setting this option to <strong>Printer's Default</strong> produces the same result as the <strong>With CRD</strong> setting. See the <em>Color Guide</em> for more information.</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Specify the color mode for the current print job. Select <strong>CMYK</strong>, <strong>Standard Color</strong>, or <strong>Expert Color</strong> for a full-color document. Select <strong>Grayscale</strong> for a grayscale or black-and-white document.</td>
<td>The <strong>Printer's default</strong> setting reflects the setting specified in RIP Station Setup. For Windows 95/98, you must choose <strong>Expert Color</strong> to set other color print options, including Pure Black Text/Graphics.</td>
</tr>
<tr>
<td>Combine Separations</td>
<td>Select <strong>On</strong> to combine separations on a single page. Select <strong>Off</strong> to view separations as four individual grayscale pages, each representing one color plate.</td>
<td>If this option is set to <strong>On</strong>, the Simulation Method must be set to <strong>Quick</strong>.</td>
</tr>
<tr>
<td>Copies</td>
<td>Specifies the number of copies of the job to print.</td>
<td></td>
</tr>
<tr>
<td>Draw Vertical Cutting Line</td>
<td>When this option is set to <strong>On</strong>, the printer draws a vertical line on your print job, based on the selected Paper Size. Cut along the line to trim your job to the appropriate width.</td>
<td>Setting this option to <strong>Printer's Default</strong> produces the same result as the <strong>Off</strong> setting. If Media Saver Mode is set to <strong>On</strong>, be sure <strong>Draw Vertical Cutting Line</strong> is set to <strong>Off</strong>.</td>
</tr>
<tr>
<td>Options and settings: (Default setting is underlined)</td>
<td>Description:</td>
<td>Requirements, constraints, and information:</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>--------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td><strong>Dry Time</strong>&lt;br&gt;<strong>Printer’s Default/None/1 second/2 seconds/3 seconds/4 seconds/5 seconds</strong></td>
<td>Specifies the length of time in seconds allowed for drying between every printing sweep.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>None</strong> setting. If you change the dry time setting to a value other than <strong>None</strong> from either the Print Options dialog box of an application or from the Fiery Spooler or WebSpooler, the setting remains in effect until it is changed by a subsequent setting. If you cancel a print job that had a dry time assigned to it, the RIP Station will still allow the dry time to expire before processing another job.</td>
</tr>
<tr>
<td><strong>Image Output</strong>&lt;br&gt;<strong>Printer’s Default/Print/Preview</strong></td>
<td>Specifies a preview of the image in the Thumbnail window. With this option set to <strong>Preview</strong>, the job previews in the Fiery Spooler or Fiery WebSpooler Thumbnail A window. To print the job after viewing the preview, click the printer icon in the Thumbnail A window. With this option set to <strong>Print</strong>, the job prints to the printer immediately.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>Print</strong> setting. For more information, see page 6-19.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>Enter instructions to the operator about the job.</td>
<td>The Instructions field has a 128-character limit. The information you enter in this area can be viewed in the Fiery WebSpooler and Fiery Spooler Override Print Settings dialog box, but does not appear in the Job Log.</td>
</tr>
<tr>
<td><strong>Mirror</strong>&lt;br&gt;<strong>Off/On</strong></td>
<td>Specifies printing a mirror image of each page of the print job.</td>
<td></td>
</tr>
<tr>
<td><strong>Media Option</strong>&lt;br&gt;<strong>Printer’s Default/ Roll Fed Media/Banner/Cut Sheet</strong></td>
<td>Specifies printing with <strong>Roll Fed, Banner</strong>, or <strong>Cut Sheet</strong> media.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>Roll Fed Media</strong> setting.</td>
</tr>
</tbody>
</table>
### Options and settings:

<table>
<thead>
<tr>
<th>Options and settings: <strong>(Default setting is underlined)</strong></th>
<th>Description:</th>
<th>Requirements, constraints, and information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Saver Mode <strong>Printer’s Default/On/Off</strong></td>
<td>Specifies whether to print multiple copies of a job and multiple pages per job across the width of the media with a 1/4” margin between pages.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>Off</strong> setting. See page A-11 for more information.</td>
</tr>
<tr>
<td>Media Width <strong>Printer’s Default/24-inch/36-inch/44-inch</strong></td>
<td>Specifies the width of the media when Media Saver Mode is <strong>On</strong>.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>44-inch</strong> setting. See page A-11 for more information.</td>
</tr>
<tr>
<td>Notes 1 and Notes 2</td>
<td>Use one or both of these fields to enter special information about the job. This information appears in the Notes 1 and 2 fields of the Fiery WebSpooler and Fiery Spooler Job Log.</td>
<td>The Notes 1 and Notes 2 fields each have a 32-character limit. This option is not available with Windows NT 4.0.</td>
</tr>
<tr>
<td>(Other) Gamma <strong>Printer’s Default/1.0/1.2/1.4/1.6/1.8/2.0/2.2/2.4/2.6/2.8/3.0</strong></td>
<td>Specifies the source gamma value for printing RGB images, objects, and text.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>2.2</strong> setting. RGB Source Profile must be <strong>Other</strong>. See page A-12 for more information.</td>
</tr>
<tr>
<td>(Other) Phosphors <strong>Printer’s Default/Hitachi EBU/Hitachi-Ikegami/NTSC/Radiu Pivot/SMPTE/Trinitron</strong></td>
<td>Specifies the source phosphors value for printing RGB images, objects, and text.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>SMPTE</strong> setting. RGB Source Profile must be <strong>Other</strong>. See page A-12 for more information.</td>
</tr>
<tr>
<td>(Other) White Point <strong>Printer’s Default/5000 K (D50)/5500 K/6500 K (D65)/7500 K/9300 K</strong></td>
<td>Specifies the source white point value for printing RGB images, objects, and text.</td>
<td>Setting this option to <strong>Printer’s Default</strong> produces the same result as the <strong>5000 K (D50)</strong> setting. RGB Source Profile must be <strong>Other</strong>. See page A-12 for more information.</td>
</tr>
<tr>
<td>Output Profile <strong>Printer’s default/Output-1/Output-2/Output-3/Output-4/Output-5/Output-6/Output-7/Output-8/Output-9/Output-10</strong></td>
<td>Specifies the output profile to be used for the current print job.</td>
<td>The <strong>Printer’s Default</strong> setting reflects the setting specified in RIP Station Setup. This option can also be set from ColorWise Pro Tools. See page A-12 and the Color Guide for more information.</td>
</tr>
<tr>
<td>Options and settings: (Default setting is underlined)</td>
<td>Description:</td>
<td>Requirements, constraints, and information:</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>--------------</td>
<td>---------------------------------------------</td>
</tr>
</tbody>
</table>
The following paper sizes apply to the SP9000 printer only: Super B0, BO, B1, B1 LEF, B1 Board LEF, B2 LEF, Super A0, A0, A1 LEF.  
**NOTE:** With the exception of B1 Board LEF, paper sizes with the LEF designation are for use with roll fed media only. B1 Board LEF is supported only when Cut Sheet media is specified. |
| **Print Mode**<br>Printer’s Default/<br>Com Prf Ppr 720x720/<br>Com Prf Ppr 1440x720/<br>DuPont Epson MAT 720x720/<br>DuPont Epson MAT 1440x720/<br>DuPont Epson PUB 720x720/<br>DuPont Epson PUB 1440x720/<br>Plain Paper Fast 360x360/<br>Plain Paper Fine 360x360/<br>PQ Glossy Paper 720x720/<br>PQ Glossy Paper 1440x720/<br>PQ InkJet Paper 720x720/<br>PQ InkJet Paper 1440x720/<br>PQ Glossy Film 720x720/<br>PQ Glossy Film 1440x720/<br>Matte Paper Fast 720x360/<br>Matte Paper Fine 720x360/<br>PQ Semi Gloss Paper 720x360/<br>PQ Semi Gloss Paper 720x720/<br>PQ Semi Gloss Paper 1440x720/<br>Reserved-1 Fast/Reserved-1 Fine/<br>Reserved-2 Fast/Reserved-2 Fine | Specifies the media type and the resolution at which the printer prints. | Setting this option to **Printer’s Default** produces the same result as the **PQ InkJet Paper 720x720** setting. |
| **Pure Black Text/Graphics**<br>Printer’s Default/Off/On | Select **Off** to print black text and graphics as a four-color black.  
Select **On** to print black text and graphics as a one-color black using 100% black ink only. | The **Printer’s Default** setting reflects the setting specified in RIP Station Setup. |
<table>
<thead>
<tr>
<th>Options and settings: (Default setting is underlined)</th>
<th>Description:</th>
<th>Requirements, constraints, and information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rendering Style</td>
<td>Specifies the color rendering dictionary (CRD) to be used when printing RGB images, objects, and text.</td>
<td>Setting this option to Printer's Default produces the same result as the Color Proofing (Photo) setting. See page A-12 for more information.</td>
</tr>
<tr>
<td>RGB Source Profile</td>
<td>Specifies the source color space definition for printing RGB images, objects, and text.</td>
<td>Setting this option to Printer's Default produces the same result as the EFIRGB setting. This option can also be set from ColorWise Pro Tools. See page A-12 and the Color Guide for more information.</td>
</tr>
<tr>
<td>RIP Mode</td>
<td>Specifies whether to RIP the job to memory or to disk.</td>
<td>Setting this option to Printer's Default produces the same result as the Memory setting. The Disk option is automatically selected for multiple copy jobs.</td>
</tr>
<tr>
<td>Scale</td>
<td>Specifies the percentage reduction or magnification at which to print the job.</td>
<td>Setting this option to Printer's Default produces the same result as the 100% setting. Percentages are available only as a Fiery Spooler or Fiery WebSpooler override. If this option is set to anything other than 100% (or Printer's Default), the Auto Scale option must be set to Printer's Default. <strong>NOTE:</strong> This option is not the same as the Scale option available from the printer driver. See page A-13 for more information.</td>
</tr>
</tbody>
</table>

Options and settings:

- **Rendering Style**
  - Printer's Default
  - Photographic/Photographic/Photographic
  - Presentation/Color Proofing (Photo)/Color Proofing (Solid)

- **RGB Source Profile**
  - Printer's Default
  - EFIRGB/sRGB (PC)
  - Apple Standard/Other

- **RIP Mode**
  - Printer's Default
  - Memory
  - Disk

- **Scale**
  - Printer's Default
  - 200%/150%/100%/75%/50%
The following sections provide additional information about print options. See the table above for information on the settings, requirements, and constraints in effect for these options.

**Auto Scale**

Use the Auto Scale feature to automatically scale an image up or down. Auto Scale is available only as a Fiery Spooler or Fiery WebSpooler job override. Auto Scale uses the job’s original paper size and the override paper size to scale the image.

**NOTE:** Do not use the Scale and Auto Scale overrides at the same time.
To scale an image using Auto Scale:

1. Use Fiery WebSpooler or Fiery Spooler to open the Override Print Settings dialog box.
   See Chapter 6 for information on how to access the Override Print Settings dialog box.

2. From the Page Size pop-up menu, select the desired page size.
   It can be larger or smaller than the original page size.

3. From the Auto Scale pop-up menu, select On.

4. Click OK.

5. Print the job.

CMYK Simulation Profile

CMYK Simulation Profile lets you specify the simulation goal for the current print job. As the job begins processing, the specified simulation goal is applied before printing.

The RIP Station provides CMYK Simulation targets for the major international press standards. You can also create custom simulations using ColorWise Pro Tools. See the Color Guide for more information.

DuPont Waterproof (COM, MAT, PUB)—Proofing standard for negative commercial printing
DuPont Cromalin (COM, MAT, PUB)—European proofing standard for offset printing
SWOP-COM/M—SWOP Commercial Matchprint
SWOP-COM/F—SWOP Commercial FujiColor Art Print
DIC—Uses the Japanese press standard.
Euroscale—Uses the European press standard.
Simulation-1 (2, 3, 4, 5 ...10)—Uses a custom simulation goal. Before selecting one of these settings, make sure the corresponding simulation goal has been created with ColorWise Pro Tools and named exactly as it appears in the list of custom simulation settings.
None—Uses no simulation goal. Select this setting when the CMYK data for your job was separated for your specific printer (for example, when using the Color Management System built into your computer to convert the CMYK data to the printer’s color space).
Combine Separations

The Combine Separations option specifies whether to combine color separations created in desktop publishing applications on a single page to simulate printing on a press from film separations. It allows you to proof overprinting, trapping, and other four-color printing effects before having film separations created. It also enables you to combine Desktop Color Separations (DCS) format files to print them at full resolution instead of printing the low-resolution master file. This option can only be specified from the printer driver.

**NOTE:** The DCS2.eps file format is not supported.

Your job must have been printed as color separations or DCS format when you printed it from your application. If you did not print the job in this manner, the Combine Separations option has no effect.

**NOTE:** The Combine Separations option is not available for separations created in Photoshop.

Media Saver Mode

When you print more than one copy of a job, the RIP Station places as many copies of each page as can fit across the width of the media. There is a 1/4" horizontal gap between copies.

You cannot print successive jobs side by side. If you print two jobs, the first job is printed, and the media advances so that you can cut it. The second job will print after the first job has been printed and the media has advanced.

The following example shows how media saver works. The number of copies placed side by side depends on the settings specified for Paper Size and Media Width.
**Output Profile**

**Output-1 through Output-10**—Uses a custom output profile. Before selecting this setting, you are required to download or create the output profile with ColorWise Pro Tools, then link it with one of the custom output profile names, e.g.- Output-1. See the *Color Guide* for more information.

**Rendering Style**

Use this option to select a color rendering dictionary (CRD) to use for color conversions when you print RGB images, objects, and text.

**Photographic**—Optimizes the range of colors on the RIP Station to produce the best results for photographic or bitmapped images.

**Presentation**—Optimizes the output of pure, saturated colors such as those used in business presentations.

**Color Proofing (Photo)**—for CMYK printing provides a close match to the device being simulated, regardless of the media being used. Also good for printing RGB images.

**Color Proofing (Solid)**—for CMYK printing provides the closest match to the device being simulated, including rendering the paper color as the background.

**RGB Source Profile**

This option is used to specify a source color space for RGB data in your document.

**EFIRGB**—Optimal source space for printing to the RIP Station. This setting also provides consistent output across different platforms.

**sRGB (PC)**—Specifies the source space of a generic Windows computer monitor.

**Apple Standard**—Specifies the source space of a standard Mac OS computer monitor.

**Other**—Allows you to specify custom RGB source settings using the *(Other) Gamma*, *(Other) Phosphors*, and *(Other) White Point* print options.

**Source-1 through Source-10**—Uses a custom source profile. Before selecting this setting, you are required to download the source profile to the RIP Station with ColorWise Pro Tools, then link it with one of the custom source profile names, e.g.- Source-1.
Scale
With Fiery Spooler or Fiery WebSpooler, you can specify a scaling override, but the override is applied to the scaling value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator specifies a Scale override of 200%, the job is printed at 100% of the original document size, that is, 50% of 200%.

Spot Color Matching
The Spot Color Matching option provides automatic matching of PANTONE library colors with their best CMYK equivalents.

- **On**—The RIP Station uses its built-in lookup table to generate the closest CMYK matches of PANTONE colors your print device can produce.
- **Off**—The RIP Station uses the CMYK equivalents defined by your application to print PANTONE colors.

For jobs that contain PANTONE library colors, set Spot Color Matching to **On** unless you are printing press simulations. When printing press simulations, set Spot Color Matching to **Off** and choose the appropriate CMYK Simulation setting.
Appendix B: Font List

This appendix lists the 136 built-in printer fonts included with your RIP Station.

Printer fonts

In addition to the fonts listed below, two Adobe Multiple Master fonts are included and are used for font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the User Software CD. For instructions, see the Setup Guide.

Adobe Type 1 fonts

The RIP Station includes 117 Adobe Type 1 fonts:

- The Mac OS column lists the name as it appears on the Font menu on a Mac OS computer. For example, in most applications, to use “Bodoni-Bold,” choose Bodoni Bold from the Font menu.

- The Windows menu name is the name as it appears on the Font menu on a Windows computer. The style refers to the style that must be selected in the application to access the particular PostScript font. For example, to use “Bodoni-Bold,” choose Bodoni from the Font menu and Bold from the Style menu.

<table>
<thead>
<tr>
<th>PostScript name</th>
<th>Mac OS menu name</th>
<th>Windows menu name, style</th>
</tr>
</thead>
<tbody>
<tr>
<td>AlbertusMT-Light</td>
<td>Albertus MT Lt</td>
<td>Albertus MT Lt</td>
</tr>
<tr>
<td>AlbertusMT</td>
<td>Albertus MT</td>
<td>Albertus MT</td>
</tr>
<tr>
<td>AlbertusMT-Italic</td>
<td>Albertus MT It</td>
<td>Albertus MT, Italic</td>
</tr>
<tr>
<td>AntiqueOlive-Roman</td>
<td>Antique Olive Roman</td>
<td>Antique Olive Roman</td>
</tr>
<tr>
<td>AntiqueOlive-Bold</td>
<td>Antique Olive Bold</td>
<td>Antique Olive Roman, Bold</td>
</tr>
<tr>
<td>AntiqueOlive-Italic</td>
<td>Antique Olive Italic</td>
<td>Antique Olive Roman, Italic</td>
</tr>
<tr>
<td>AntiqueOlive-Compact</td>
<td>Antique Olive Compact</td>
<td>Antique Olive Compact</td>
</tr>
<tr>
<td>AvantGarde-Book</td>
<td>Avant Garde</td>
<td>Avant Garde</td>
</tr>
<tr>
<td>AvantGarde-Demi</td>
<td>Avant Garde Demi</td>
<td>Avant Garde, Bold</td>
</tr>
<tr>
<td>AvantGarde-BookOblique</td>
<td>Avant Garde BookOblique</td>
<td>Avant Garde, Bold Oblique</td>
</tr>
<tr>
<td>AvantGarde-DemiOblique</td>
<td>Avant Garde DemiOblique</td>
<td>Avant Garde, Bold Oblique</td>
</tr>
<tr>
<td>Bodoni</td>
<td>Bodoni</td>
<td>Bodoni</td>
</tr>
<tr>
<td>PostScript name:</td>
<td>Mac OS menu name:</td>
<td>Windows menu name, style:</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Bodoni-Bold</td>
<td>Bodoni Bold</td>
<td>Bodoni, Bold</td>
</tr>
<tr>
<td>Bodoni-Italic</td>
<td>Bodoni Italic</td>
<td>Bodoni, Italic</td>
</tr>
<tr>
<td>Bodoni-BoldItalic</td>
<td>Bodoni BoldItalic</td>
<td>Bodoni, Bold Italic</td>
</tr>
<tr>
<td>Bodoni-Poster</td>
<td>Bodoni Poster</td>
<td>Bodoni Poster</td>
</tr>
<tr>
<td>Bodoni-PosterCompressed</td>
<td>Bodoni PosterCompressed</td>
<td>Bodoni PosterCompressed</td>
</tr>
<tr>
<td>Bookman-Light</td>
<td>Bookman</td>
<td>Bookman</td>
</tr>
<tr>
<td>Bookman-Demi</td>
<td>Bookman Demi</td>
<td>Bookman, Bold</td>
</tr>
<tr>
<td>Bookman-LightItalic</td>
<td>Bookman LightItalic</td>
<td>Bookman, Italic</td>
</tr>
<tr>
<td>Bookman-DemiItalic</td>
<td>Bookman DemiItalic</td>
<td>Bookman, Bold Italic</td>
</tr>
<tr>
<td>Carta</td>
<td>Carta</td>
<td>Carta</td>
</tr>
<tr>
<td>Clarendon-Light</td>
<td>Clarendon Light</td>
<td>Clarendon Light</td>
</tr>
<tr>
<td>Clarendon</td>
<td>Clarendon</td>
<td>Clarendon</td>
</tr>
<tr>
<td>Clarendon-Bold</td>
<td>Clarendon Bold</td>
<td>Clarendon Bold</td>
</tr>
<tr>
<td>CooperBlack</td>
<td>Cooper Black</td>
<td>Cooper Black</td>
</tr>
<tr>
<td>CooperBlack-Italic</td>
<td>Cooper Black Italic</td>
<td>Cooper Black, Italic</td>
</tr>
<tr>
<td>Copperplate-ThirtyThreeBC</td>
<td>Copperplate33bc</td>
<td>Copperplate33bc</td>
</tr>
<tr>
<td>Copperplate-ThirtyTwoBC</td>
<td>Copperplate32bc</td>
<td>Copperplate32bc</td>
</tr>
<tr>
<td>Coronet</td>
<td>Coronet</td>
<td>Coronet</td>
</tr>
<tr>
<td>Courier</td>
<td>Courier</td>
<td>Courier</td>
</tr>
<tr>
<td>Courier-Bold</td>
<td>Courier Bold</td>
<td>Courier, Bold</td>
</tr>
<tr>
<td>Courier-Oblique</td>
<td>Courier Oblique</td>
<td>Courier, Italic</td>
</tr>
<tr>
<td>Courier-BoldOblique</td>
<td>Courier BoldOblique</td>
<td>Courier, Bold Italic</td>
</tr>
<tr>
<td>Eurostile</td>
<td>Eurostile</td>
<td>Eurostile</td>
</tr>
<tr>
<td>Eurostile-Bold</td>
<td>Eurostile Bold</td>
<td>Eurostile Bold</td>
</tr>
<tr>
<td>Eurostile-ExtendedTwo</td>
<td>Eurostile ExtendedTwo</td>
<td>Eurostile ExtendedTwo</td>
</tr>
<tr>
<td>Eurostile-BoldExtendedTwo</td>
<td>Eurostile BoldExtendedTwo</td>
<td>Eurostile ExtendedTwo, Bold</td>
</tr>
<tr>
<td>GillSans</td>
<td>GillSans</td>
<td>GillSans</td>
</tr>
<tr>
<td>GillSans-Bold</td>
<td>GillSans Bold</td>
<td>GillSans, Bold</td>
</tr>
<tr>
<td>GillSans-Italic</td>
<td>GillSans Italic</td>
<td>GillSans, Italic</td>
</tr>
<tr>
<td>GillSans-BoldItalic</td>
<td>GillSans BoldItalic</td>
<td>GillSans, Bold Italic</td>
</tr>
<tr>
<td>GillSans-Light</td>
<td>GillSans Light</td>
<td>GillSans Light</td>
</tr>
<tr>
<td>GillSans-LightItalic</td>
<td>GillSans LightItalic</td>
<td>GillSans Light, Italic</td>
</tr>
<tr>
<td>GillSans-Condensed</td>
<td>GillSans Condensed</td>
<td>GillSans Condensed</td>
</tr>
<tr>
<td>GillSans-BoldCondensed</td>
<td>GillSans BoldCondensed</td>
<td>GillSans Condensed, Bold</td>
</tr>
<tr>
<td>PostScript name:</td>
<td>Mac OS menu name:</td>
<td>Windows menu name, style:</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>GillSans-ExtraBold</td>
<td>GillSans ExtraBold</td>
<td>GillSans ExtraBold</td>
</tr>
<tr>
<td>Goudy</td>
<td>Goudy</td>
<td>Goudy</td>
</tr>
<tr>
<td>Goudy-Bold</td>
<td>Goudy Bold</td>
<td>Goudy, Bold</td>
</tr>
<tr>
<td>Goudy-Italic</td>
<td>Goudy Italic</td>
<td>Goudy, Italic</td>
</tr>
<tr>
<td>Goudy-BoldItalic</td>
<td>Goudy BoldItalic</td>
<td>Goudy, Bold Italic</td>
</tr>
<tr>
<td>Goudy-ExtraBold</td>
<td>Goudy ExtraBold</td>
<td>Goudy ExtraBold</td>
</tr>
<tr>
<td>Helvetica</td>
<td>Helvetica</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Helvetica-Bold</td>
<td>Helvetica Bold</td>
<td>Helvetica, Bold</td>
</tr>
<tr>
<td>Helvetica-Oblique</td>
<td>Helvetica Oblique</td>
<td>Helvetica, Italic</td>
</tr>
<tr>
<td>Helvetica-BoldOblique</td>
<td>Helvetica BoldOblique</td>
<td>Helvetica-Bold, Bold</td>
</tr>
<tr>
<td>Helvetica-Narrow</td>
<td>Helvetica Narrow</td>
<td>Helvetica-Narrow</td>
</tr>
<tr>
<td>Helvetica-Condensed</td>
<td>Helvetica Condensed</td>
<td>Helvetica-Condensed</td>
</tr>
<tr>
<td>Helvetica-Condensed-Bold</td>
<td>Helvetica CondensedBold</td>
<td>Helvetica-Condensed-Bold</td>
</tr>
<tr>
<td>Helvetica-Condensed-Oblique</td>
<td>Helvetica CondensedOblique</td>
<td>Helvetica-Condensed, Oblique</td>
</tr>
<tr>
<td>Helvetica-Condensed-BoldOblique</td>
<td>Helvetica CondensedBoldOblique</td>
<td>Helvetica-Condensed, BoldOblique</td>
</tr>
<tr>
<td>JoannaMT</td>
<td>Joanna MT</td>
<td>Joanna MT</td>
</tr>
<tr>
<td>JoannaMT-Bold</td>
<td>Joanna MT Bd</td>
<td>Joanna MT, Bold</td>
</tr>
<tr>
<td>JoannaMT-Italic</td>
<td>Joanna MT It</td>
<td>Joanna MT, Italic</td>
</tr>
<tr>
<td>JoannaMT-BoldItalic</td>
<td>Joanna MT Bd It</td>
<td>Joanna MT, BoldItalic</td>
</tr>
<tr>
<td>LetterGothic</td>
<td>Letter Gothic</td>
<td>Letter Gothic</td>
</tr>
<tr>
<td>LetterGothic-Bold</td>
<td>Letter Gothic Bold</td>
<td>Letter Gothic, Bold</td>
</tr>
<tr>
<td>LetterGothic-Slanted</td>
<td>Letter Gothic Slanted</td>
<td>Letter Gothic, Italic</td>
</tr>
<tr>
<td>LetterGothic-BoldSlanted</td>
<td>Letter Gothic BoldSlanted</td>
<td>Letter Gothic, BoldItalic</td>
</tr>
<tr>
<td>LubalinGraph-Book</td>
<td>Lubalin Graph</td>
<td>LubalinGraph</td>
</tr>
<tr>
<td>LubalinGraph-Demi</td>
<td>Lubalin Graph Demi</td>
<td>LubalinGraph, Bold</td>
</tr>
<tr>
<td>LubalinGraph-BookOblique</td>
<td>Lubalin Graph BookOblique</td>
<td>LubalinGraph, Bold</td>
</tr>
<tr>
<td>LubalinGraph-DemiOblique</td>
<td>Lubalin Graph DemiOblique</td>
<td>LubalinGraph, Bold</td>
</tr>
<tr>
<td>Marigold</td>
<td>Marigold</td>
<td>Marigold</td>
</tr>
<tr>
<td>MonaLisa-Recut</td>
<td>Mona Lisa Recut</td>
<td>Mona Lisa Recut</td>
</tr>
<tr>
<td>NewCenturySchlbk-Roman</td>
<td>New Century Schlbk</td>
<td>NewCenturySchlbk</td>
</tr>
<tr>
<td>NewCenturySchlbk-Bold</td>
<td>New Century Schlbk Bold</td>
<td>NewCenturySchlbk, Bold</td>
</tr>
<tr>
<td>PostScript name:</td>
<td>Mac OS menu name:</td>
<td>Windows menu name, style:</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>NewCenturySchlbk-Italic</td>
<td>New Century Schlbk Italic</td>
<td>NewCenturySchlbk, Italic</td>
</tr>
<tr>
<td>NewCenturySchlbk-BoldItalic</td>
<td>New Century Schlbk BoldIt</td>
<td>NewCenturySchlbk, BoldItalic</td>
</tr>
<tr>
<td>Optima</td>
<td>Optima</td>
<td>Optima</td>
</tr>
<tr>
<td>Optima-Bold</td>
<td>Optima Bold</td>
<td>Optima, Bold</td>
</tr>
<tr>
<td>Optima-Italic</td>
<td>OptimaItalic</td>
<td>Optima, Italic</td>
</tr>
<tr>
<td>Optima-BoldItalic</td>
<td>Optima BoldItalic</td>
<td>Optima, BoldItalic</td>
</tr>
<tr>
<td>Oxford</td>
<td>Oxford</td>
<td>Oxford</td>
</tr>
<tr>
<td>Palatino-Roman</td>
<td>Palatino</td>
<td>Palatino</td>
</tr>
<tr>
<td>Palatino-Bold</td>
<td>Palatino Bold</td>
<td>Palatino, Bold</td>
</tr>
<tr>
<td>Palatino-Italic</td>
<td>PalatinoItalic</td>
<td>Palatino, Italic</td>
</tr>
<tr>
<td>Palatino-BoldItalic</td>
<td>Palatino BoldItalic</td>
<td>Palatino, BoldItalic</td>
</tr>
<tr>
<td>StempelGaramond-Roman</td>
<td>StempelGaramond Roman</td>
<td>StempelGaramond Roman</td>
</tr>
<tr>
<td>StempelGaramond-Bold</td>
<td>StempelGaramond Bold</td>
<td>StempelGaramond Roman, Bold</td>
</tr>
<tr>
<td>StempelGaramond-Italic</td>
<td>StempelGaramond Italic</td>
<td>StempelGaramond Roman, Italic</td>
</tr>
<tr>
<td>StempelGaramond-BoldItalic</td>
<td>StempelGaramond BoldItalic</td>
<td>StempelGaramond Roman, BoldItalic</td>
</tr>
<tr>
<td>Symbol</td>
<td>Symbol</td>
<td>Symbol</td>
</tr>
<tr>
<td>Tekton</td>
<td>Tekton</td>
<td>Tekton</td>
</tr>
<tr>
<td>Times-Roman</td>
<td>Times</td>
<td>Times</td>
</tr>
<tr>
<td>Times-Bold</td>
<td>Times Bold</td>
<td>Times, Bold</td>
</tr>
<tr>
<td>Times-Italic</td>
<td>Times Italic</td>
<td>Times, Italic</td>
</tr>
<tr>
<td>Times-BoldItalic</td>
<td>Times BoldItalic</td>
<td>Times, BoldItalic</td>
</tr>
<tr>
<td>Univers-Extended</td>
<td>Univers Extended</td>
<td>Univers Extended</td>
</tr>
<tr>
<td>Univers-BoldExt</td>
<td>Univers BoldExt</td>
<td>Univers Extended, Bold</td>
</tr>
<tr>
<td>Univers-ExtendedObli</td>
<td>Univers ExtendedObli</td>
<td>Univers Extended, Obli</td>
</tr>
<tr>
<td>Univers-BoldExtObli</td>
<td>Univers BoldExtObli</td>
<td>Univers Extended, Bold Obli</td>
</tr>
<tr>
<td>Univers-Light</td>
<td>Univers 45 Light</td>
<td>Univers 45 Light</td>
</tr>
<tr>
<td>Univers-Bold</td>
<td>Univers 65 Bold</td>
<td>Univers 45 Light, Bold</td>
</tr>
<tr>
<td>Univers-LightOblique</td>
<td>Univers 45 LightOblique</td>
<td>Univers 45 Light, Oblique</td>
</tr>
<tr>
<td>Univers-BoldOblique</td>
<td>Univers 65 BoldOblique</td>
<td>Univers 45 Light, Bold Obli</td>
</tr>
<tr>
<td>Univers</td>
<td>Univers 55</td>
<td>Univers 55</td>
</tr>
<tr>
<td>Univers-Oblique</td>
<td>Univers 55 Oblique</td>
<td>Univers 55, Oblique</td>
</tr>
<tr>
<td>Univers-CondensedBold</td>
<td>Univers 67 CondensedBold</td>
<td>Univers 47 CondensedLight, Bold</td>
</tr>
</tbody>
</table>
The RIP Station includes 19 TrueType fonts:

<table>
<thead>
<tr>
<th>PostScript name</th>
<th>Mac OS menu name</th>
<th>Windows menu name, style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Univers-CondensedBoldOblique</td>
<td>Univers 67 CondensedBoldObl</td>
<td>Univers 47 CondensedLight, Bold Italic</td>
</tr>
<tr>
<td>Univers-Condensed</td>
<td>Univers 57 Condensed</td>
<td>Univers 57 Condensed</td>
</tr>
<tr>
<td>Univers-CondensedOblique</td>
<td>Univers 57 CondensedOblique</td>
<td>Univers 57 Condensed, Italic</td>
</tr>
<tr>
<td>ZapfChancery-MediumItalic</td>
<td>Zapf Chancery</td>
<td>ZapfChancery</td>
</tr>
<tr>
<td>ZapfDingbats</td>
<td>Zapf Dingbats</td>
<td>ZapfDingbats</td>
</tr>
<tr>
<td>Apple-Chancery</td>
<td>Apple Chancery</td>
<td>Apple Chancery</td>
</tr>
<tr>
<td>Arial-BoldItalicMT</td>
<td>Arial Bold Italic</td>
<td>Arial, Bold Italic</td>
</tr>
<tr>
<td>Arial-BoldMT</td>
<td>Arial Bold</td>
<td>Arial, Bold</td>
</tr>
<tr>
<td>Arial-ItalicMT</td>
<td>Arial Italic</td>
<td>Arial, Italic</td>
</tr>
<tr>
<td>ArialMT</td>
<td>Arial</td>
<td>Arial</td>
</tr>
<tr>
<td>Chicago</td>
<td>Chicago</td>
<td>Chicago</td>
</tr>
<tr>
<td>Geneva</td>
<td>Geneva</td>
<td>Geneva</td>
</tr>
<tr>
<td>HoeflerText-Black</td>
<td>Hoefler Text Black</td>
<td>Hoefler Text Black</td>
</tr>
<tr>
<td>HoeflerText-BlackItalic</td>
<td>Hoefler Text Black, Italic</td>
<td>Hoefler Text Black, Italic</td>
</tr>
<tr>
<td>HoeflerText-Italic</td>
<td>Hoefler Text</td>
<td>Hoefler Text, Italic</td>
</tr>
<tr>
<td>HoeflerText-Ornaments</td>
<td>Hoefler Text Ornaments</td>
<td>Hoefler Text Ornaments</td>
</tr>
<tr>
<td>HoeflerText-Regular</td>
<td>Hoefler Text</td>
<td>Hoefler Text</td>
</tr>
<tr>
<td>Monaco</td>
<td>Monaco</td>
<td>Monaco</td>
</tr>
<tr>
<td>New York</td>
<td>New York</td>
<td>New York</td>
</tr>
<tr>
<td>TimesNewRomanPS-BoldMT</td>
<td>Times New Roman Bold</td>
<td>Times New Roman, Bold</td>
</tr>
<tr>
<td>TimesNewRomanPS-BoldItalicMT</td>
<td>Times New Roman Bold Italic</td>
<td>Times New Roman, Bold Italic</td>
</tr>
<tr>
<td>TimesNewRomanPS-ItalicMT</td>
<td>Times New Roman Italic</td>
<td>Times New Roman, Italic</td>
</tr>
<tr>
<td>TimesNewRomanPSMT</td>
<td>Times New Roman</td>
<td>Times New Roman, Italic</td>
</tr>
<tr>
<td>Wingdings-Regular</td>
<td>Wingdings</td>
<td>Wingdings</td>
</tr>
</tbody>
</table>
This appendix provides a list of error messages that may appear on the RIP Station Control Panel, as well as troubleshooting tips.

## Error messages

Error messages can result from problems with the print job or the RIP Station. Some of the most common error conditions are listed here.

<table>
<thead>
<tr>
<th>RIP Station message:</th>
<th>Corrective action/additional information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Out</td>
<td>An ink cartridge is out. Replace the appropriate ink cartridge.</td>
</tr>
<tr>
<td>Media Jam</td>
<td>There is a paper jam in the printer. Clear the media jam.</td>
</tr>
<tr>
<td>Media Out</td>
<td>Media is out. Replace the media.</td>
</tr>
<tr>
<td>Cover Open</td>
<td>The printer cover is open. Close the printer cover.</td>
</tr>
<tr>
<td>Load &lt;Paper&gt;</td>
<td>The printer is not loaded with the specified paper size. Load the specified paper size.</td>
</tr>
<tr>
<td>Load &lt;Paper&gt; Load &lt;Media&gt;</td>
<td>The printer is not loaded with the specified paper size and media type. Load the specified paper size and media type.</td>
</tr>
<tr>
<td>Printer Not Connected</td>
<td>Check the power to the printer and the printer's connection to the RIP Station.</td>
</tr>
<tr>
<td>Printer Status Unknown</td>
<td>There may be a problem with the printer or the RIP Station. Restart the printer or the RIP Station.</td>
</tr>
</tbody>
</table>
Maintaining optimal system performance

The RIP Station does not require maintenance. Beyond the routine requirements of servicing and maintaining the printer and replenishing consumables there are a few things you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because several users are running utilities that are updated often. Large numbers of remote users running the Fiery utilities may have a significant effect on RIP Station performance.

• Schedule the printing workload before printing.

Print jobs with the same output and paper specifications together to minimize paper changes. Also, print routine jobs while you prepare to print jobs with special instructions or special media.

• Avoid printing with the server “Disk full” warning.

If you see this warning, delete jobs from the Queues window that have been held for a long time and are not likely to be needed. Avoid this condition by deleting old jobs on a regular basis. The date associated with a job is the original date it was sent.

Troubleshooting

In case of problems, and before you call for service, check the guidelines in this section. If you are unable to resolve the problem, make a note of the error condition and contact your authorized service/support center.

This section provides some troubleshooting guidelines should a problem arise. If you are unable to resolve a problem after referring to this section, contact your site operator or administrator.
## General printing problems

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot select or view one of the queues.</td>
<td>• Have your system administrator enable the queue in Setup.</td>
</tr>
<tr>
<td>Printing ties up your computer for too long.</td>
<td>• Print to a queue instead of the Direct connection.</td>
</tr>
<tr>
<td>• When you print to a queue, the job is stored on the RIP Station until it can</td>
<td>• Check the RIP Station print option “Image Output.”</td>
</tr>
<tr>
<td>be processed and printed; when you print to the Direct connection, the job</td>
<td>• If this option is on, the job is displayed in the Thumbnail A window of</td>
</tr>
<tr>
<td>cannot be sent to the RIP Station until the previous job is finished</td>
<td>Fiery WebSpooler or Fiery Spooler. Open this window and click the print</td>
</tr>
<tr>
<td>processing, but the job never prints.</td>
<td>icon next to the previewed image.</td>
</tr>
<tr>
<td>Message requests a paper size that you don’t have.</td>
<td>• Cancel the job and do one of the following:</td>
</tr>
<tr>
<td>• If you are printing a file from an application, change the page size in</td>
<td>• Did you select the RIP Station as the current printer?</td>
</tr>
<tr>
<td>the Page Setup dialog box.</td>
<td>Before printing, you must select the RIP Station as the current printer</td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td>from your Mac OS, Windows, or UNIX workstation.</td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td>queue is being used by the RIP Station.</td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td>• Make sure that the job does not contain a PostScript error.</td>
</tr>
<tr>
<td>• Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to</td>
</tr>
<tr>
<td>the job’s status.</td>
<td>check the job’s status. A job containing a PostScript error appears in</td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td>red in the Fiery WebSpooler and Fiery Spooler displays.</td>
</tr>
<tr>
<td>To obtain information on the PostScript error, make sure the Print to PS</td>
<td></td>
</tr>
<tr>
<td>Error setup option is set to Yes.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
<tr>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check</td>
<td></td>
</tr>
<tr>
<td>the job’s status.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the printer is switched on.</td>
<td></td>
</tr>
<tr>
<td>• If you are printing over an IPX (Novell) network, verify through the</td>
<td></td>
</tr>
<tr>
<td>PCONSOLE utility that the job was sent to the Novell queue and that the</td>
<td></td>
</tr>
<tr>
<td>queue is being used by the RIP Station.</td>
<td></td>
</tr>
<tr>
<td>• Make sure that the job does not contain a PostScript error.</td>
<td></td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Test Page, or other pages, do not print from the Control Panel.</td>
<td>• Check the printer display for an error message and correct the problem.</td>
</tr>
<tr>
<td></td>
<td>• Restart the RIP Station. If there is no error message at the printer, you should restart the RIP Station as described on page 1-7.</td>
</tr>
<tr>
<td>The RIP Station doesn’t appear in the Mac OS computer’s Chooser list of printers.</td>
<td>1. On the Mac OS computer, make sure that the correct zone is selected and that AppleTalk is active.</td>
</tr>
<tr>
<td></td>
<td>AppleTalk must be active. The RIP Station may be in a different zone from the one that’s selected (if your network doesn’t have zones, this is not applicable). Print the Configuration page from the Functions &gt; Print Pages menu to view the correct AppleTalk zone.</td>
</tr>
<tr>
<td></td>
<td>2. Does the RIP Station appear in the Chooser on another Mac OS computer on the same network?</td>
</tr>
<tr>
<td></td>
<td>If there is another Mac OS computer nearby, check to see if the RIP Station appears in the Chooser on that Mac OS computer. If the RIP Station is visible from one Mac OS computer, but not from another, there may be a problem with the way the second Mac OS computer is connected to the network. Check all the cabling and other connections, and verify that the network is properly terminated. If there is a 10BaseT transceiver on the network, make sure that its green link integrity light is on. For more information about the network, refer to the documentation provided with the network hardware.</td>
</tr>
<tr>
<td></td>
<td>3. Do other printers on the network appear in the Chooser?</td>
</tr>
<tr>
<td></td>
<td>If your network includes printers other than the RIP Station, they should appear in the Chooser. If none of the printers appear in the Chooser list, there is most likely a problem with the way the Mac OS computer is connected to the network. Check all the cabling and other connections. For more information about the network, refer to the documentation provided with the network hardware.</td>
</tr>
<tr>
<td></td>
<td>If other printers appear in the Chooser, there may be a problem with the RIP Station connection. Contact your RIP Station system administrator.</td>
</tr>
<tr>
<td></td>
<td>4. Try printing a test page from the Functions &gt; Print Pages menu.</td>
</tr>
<tr>
<td></td>
<td>If you’re able to print the test page, but RIP Station still does not appear in the Chooser, contact your authorized service/support center.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Jobs sent to the parallel port do not print.

- Review the procedures provided in the *Setup Guide* on how to prepare the RIP Station and your Windows 95/98 computer for parallel port printing.

  Also see your Windows 95/98 documentation.

- **Ask the administrator to increase the parallel Port Timeout in Seconds on the RIP Station Control Panel.**

- **Ask the administrator to change the Ignore EOF Character setting on the RIP Station Control Panel.**

  If you will be printing ASCII format PostScript only, set Ignore EOF Character to No; if you will be printing Binary format PostScript, set it to Yes.

- **If you print using the DOS copy command, make sure to use the /b option when printing binary files.**

- **If you are printing using Fiery Downloader, make sure you have a network connection.**

  Fiery Downloader is not supported over the parallel port.

### You get poor printing results.

- **Does your application require one of the RIP Station printer description files?**

  If you’re printing from Adobe PageMaker, make sure that the RIP Station printer description file is installed correctly. For information about installing these files, see the *Setup Guide* and the documentation for your application software.

- **Make sure the system has been calibrated.** See the *Color Guide*.  

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
</table>
| Jobs sent to the parallel port do not print. | • Review the procedures provided in the *Setup Guide* on how to prepare the RIP Station and your Windows 95/98 computer for parallel port printing.  

  Also see your Windows 95/98 documentation.  

  • **Ask the administrator to increase the parallel Port Timeout in Seconds on the RIP Station Control Panel.**  

  • **Ask the administrator to change the Ignore EOF Character setting on the RIP Station Control Panel.**  

    If you will be printing ASCII format PostScript only, set Ignore EOF Character to No; if you will be printing Binary format PostScript, set it to Yes.  

  • **If you print using the DOS copy command, make sure to use the /b option when printing binary files.**  

  • **If you are printing using Fiery Downloader, make sure you have a network connection.**  

    Fiery Downloader is not supported over the parallel port. |
| Print settings for your job output do not match the settings you gave. | • **Make sure that you did not override the setting for the job in another place.**  

  For information about options and overrides, see Appendix A "Print Options." |
| You get poor printing results. | • **Does your application require one of the RIP Station printer description files?**  

  If you’re printing from Adobe PageMaker, make sure that the RIP Station printer description file is installed correctly. For information about installing these files, see the *Setup Guide* and the documentation for your application software.  

  • **Make sure the system has been calibrated.** See the *Color Guide*. |
### Troublehooting

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separations do not combine properly.</td>
<td>• Make sure that the file was initially created as separations.</td>
</tr>
<tr>
<td></td>
<td>• If you are printing separations or a DCS format file, set the Combine Separations print option to On. With Combine Separations On, all four colors will be printed on a single page; with Combine Separations Off, four grayscale pages will print to simulate four single-color plates.</td>
</tr>
<tr>
<td>The registration or colors of an image are not what you expected.</td>
<td>• Ask the operator to print a test page on the printer. The problem may be with the printer. If your test page shows that the printer is working properly, correct the problem within your application software. If the test page is wrong, your printer may need to be calibrated or adjusted in some other way.</td>
</tr>
<tr>
<td>Your printed file appears too dark.</td>
<td>• Adjust the Brightness option. You can use the Brightness option when printing from an application or from Fiery Downloader to lighten your image whenever you print a PostScript or Encapsulated PostScript (EPS) file.</td>
</tr>
<tr>
<td>Color output is incorrect.</td>
<td>• Check with the operator or administrator about the current calibration information. The printer may need to be recalibrated because it has been too long since it was calibrated or because it is using a different target.</td>
</tr>
<tr>
<td>Color file prints in black and white.</td>
<td>• On Mac OS, in the Color Matching dialog box, make sure that Color/Grayscale or ColorSync Color Matching or PostScript Color Matching is selected (not Black and White).</td>
</tr>
<tr>
<td></td>
<td>• On Windows, make sure that the Print Mode print option is set to CMYK or Standard Color/Expert Color and not Grayscale.</td>
</tr>
<tr>
<td>Desktop Color Separations (DCS) format images print incorrectly.</td>
<td>• Make sure that you selected the correct options to send separations in the application’s Print dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that you have the file for every layer of separation that you are printing.</td>
</tr>
<tr>
<td></td>
<td>• Set the Combine Separations option to On. This combines the high-resolution files for an image and prints them. With Combine Separations Off, the low-resolution master file will print.</td>
</tr>
<tr>
<td>QuickDraw fill patterns print as solids.</td>
<td>• Use the Adobe PostScript Printer driver (or the Apple LaserWriter 8.3 or later printer driver).</td>
</tr>
</tbody>
</table>
### Problems with Fiery Spooler

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>General problems</td>
<td>• Make sure that the connections are properly set.</td>
</tr>
<tr>
<td></td>
<td>See the <a href="#">Setup Guide</a>.</td>
</tr>
</tbody>
</table>

### Problems with Fiery Downloader

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>General problems</td>
<td>• Make sure that the connections are properly set.</td>
</tr>
<tr>
<td></td>
<td>See the <a href="#">Setup Guide</a>.</td>
</tr>
<tr>
<td>You can’t print an EPS file using Fiery Downloader.</td>
<td>• Turn on the “Showpage” option (Mac OS) or the “showpage after EPS files” (Windows) in the Download PostScript File dialog box.</td>
</tr>
<tr>
<td></td>
<td>The showpage option adds a showpage PostScript language command at the end of the print job. Certain applications omit this necessary PostScript language command when they generate EPS files. You’ll need to select the Append Showpage option when printing EPS files generated by these applications.</td>
</tr>
<tr>
<td></td>
<td>If you continue having difficulties printing an EPS file with Fiery Downloader, try printing the file from the application in which it was created.</td>
</tr>
<tr>
<td></td>
<td>• Turn off the “Showpage” option (Mac OS) or the “showpage after EPS files” (Windows) in the Download PostScript File dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the job does not contain a PostScript error.</td>
</tr>
<tr>
<td></td>
<td>Check with the operator, or use Fiery WebSpooler or Fiery Spooler to check the job’s status. A job containing a PostScript error appears in red in the Fiery WebSpooler and Fiery Spooler displays.</td>
</tr>
<tr>
<td></td>
<td>To obtain information on the PostScript error, make sure the Print to PS Error setup option is set to Yes. See the Administrator Guide for more information.</td>
</tr>
<tr>
<td>You have problems downloading a font with Fiery Downloader.</td>
<td>• Check with the administrator to make sure that the Direct connection is enabled.</td>
</tr>
<tr>
<td></td>
<td>The Direct connection must be used to download fonts. (Files can be downloaded via the Print or Hold queue.)</td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Problems with Fiery WebTools

<table>
<thead>
<tr>
<th>If this happens:</th>
<th>Try this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra blank page prints after a Fiery Downloader job.</td>
<td>• Turn off the “Showpage (after EPS file)” option. This option adds a special PostScript command that will cause an extra blank page to print if it is not needed.</td>
</tr>
<tr>
<td>You cannot connect to Fiery WebTools, or it takes a long time to connect.</td>
<td>• Check with the administrator to make sure Web Services are enabled in RIP Station Setup.</td>
</tr>
<tr>
<td></td>
<td>• Make sure you have the correct IP address or DNS name for the RIP Station.</td>
</tr>
<tr>
<td></td>
<td>Check with the administrator or print a Configuration page from the RIP Station Control Panel.</td>
</tr>
<tr>
<td></td>
<td>• Clear the cache (Netscape Communicator) or history (Microsoft Internet Explorer).</td>
</tr>
</tbody>
</table>
Index

A
access
  levels 6-3
  restricting 6-4
Administrator password 6-3, 6-4
Adobe Font Downloader, see Font Downloader
Alert Status screen 1-3
Apple Standard setting, RGB Source Profile option A-12
Auto Scale job override A-3
Auto Sheet Cut, described A-3

B
Bi-Directional printing option A-3
Brightness option A-1, A-3
buttons, Control Panel 1-2

C
cancel command (UNIX) 4-3
Canceled Job
  from the Control Panel during printing 1-3
  from the Control Panel during RIPping 1-3
Chooser, Mac OS C-4
Chooser window (Mac OS), selecting color server in 3-1 to 3-2
CMYK Simulation Method option A-4
CMYK Simulation option A-3
color, troubleshooting output C-6
Color Charts
  printing from the Control Panel 1-5
Color Mode option A-4
Color Proofing (Photo) rendering style A-12
Color Proofing (Solid) rendering style A-12
color rendering dictionaries, see CRDs
color server
documentation xii
color server
  selecting as current printer 3-1
Combine Separations option A-4, A-11
Command WorkStation
  using Fiery Downloader from 5-1
Configuration page
  printing from the Control Panel 1-5
Configure button
  Fiery WebTools 6-4
Connection Type option 5-5
Control Panel 1-1 to 1-7
  activity light 1-2, 1-4
  buttons 1-2
down button 1-2
Functions menu 1-4
line selection buttons 1-2
Menu button 1-2
status screens 1-3
up button 1-2
Control Panel, overriding printer settings 2-16, 2-20
Control Panel map
  printing from the Control Panel 1-5
Copies option A-4
CRDs (color rendering dictionaries) A-8
Custom Paper Sizes
  defining for Mac OS 3-5
defining for Windows 2000
  computers 2-21
defining for Windows 95/98
  computers 2-12
defining for Windows computers 2-21
custom simulations A-10
DCS (Desktop Color Separations) files A-4, A-11
default settings, see printer default settings
Delete command 6-13, 6-16
Delete Job Log command 6-13
Desktop Color Separations, see DCS
DIC simulation A-10
differences
between Fiery Spooler for Mac OS and Fiery WebSpooler 6-23
Direct connection xv, 6-15, C-7
downloading fonts 5-8
disk space used 6-11
display window 1-3
down button 1-2
Downloader, see Fiery Downloader
downloaders, LaserWriter 5-1
Draw Vertical Cutting Line option A-4
Dry Time option A-5
Duplicate Job(s) command 6-13
DuPont Cromalin simulations A-10
DuPont Waterproof simulations A-10
downloading file or font 5-4 to 5-7
Download Progress bar 5-2
Hard Disk area 5-2
installing printer fonts 5-9
Mac OS 3-7
printing from 5-4
Print Status area 5-2
restriction with parallel port 2-23
RIP Status area 5-2
Toolbar 5-3
troubleshooting C-7 to C-8
using 5-1
Windows 2000 2-1
Windows 95/98 2-1
Windows NT 4.0 2-1
Fiery Spooler
accessing on a Windows computer 6-9
for Windows 6-7
job icons (Windows) 6-14
troubleshooting C-7
Fiery Spooler, overriding Printer Setup 2-4
Fiery Spooler for Mac OS
differences from Fiery WebSpooler 6-23
Fiery WebSpooler
accessing 6-7
Guest (view-only) privileges 6-10
job icons 6-14
Job menu 6-16
Operator password 6-10
overview 6-2
Process Next command 6-16
Remove Raster command 6-17
status bars 6-11
Fiery WebTools 6-2
accessing xv, 6-4, 6-5
Configure button 6-4
home page 6-4
Installer 6-2
passwords 6-3
Print Monitor 6-2, 6-6
problems with C-8
Status 6-2, 6-5
WebLink 6-2, 6-6
WebSetup 6-2
WebSpooler 2-4, 2-16, 2-20, 6-2, A-2
File menu commands 6-13
File name entry field 5-6
File port, saving files to 2-24
Files of type menu (Windows) 5-5
Font Downloader 5-1
font list
displaying 5-3, 5-10
printing 5-3, 5-10
Font List button 5-3
fonts
Adobe Type 1 5-8, 5-9, B-1
downloading and managing 5-1, 5-5, 5-8
installing 5-9
PostScript 5-9, B-1
printer fonts 5-8
printer fonts on server 1-5, 5-10
printing font list 1-5
screen fonts 5-8
substitution with PDF files 5-9
TrueType 5-8, B-5
Font Substitution Table 5-8
Functions menu, Control Panel 1-4

G
Gamma option A-6
Guest access 6-3, 6-10

H
Help menu commands 6-13
Hold command 6-13, 6-16
Hold queue xv

I
icons
Print area 6-15
Spool area 6-14
Image Preview option A-5

Info Status screen 1-4
Installer WebTool, see Fiery WebTools
installing printer fonts 5-9
Instructions field 2-5

J
job
areas 6-11
deleting 6-16
limit 6-15
overrides 6-18
previewing A-5
job, defined xiii
job icons
Print area 6-15
Spool area 6-14
Job Log
displaying 6-20
printing from the Control Panel 1-5
using (from Fiery WebSpooler) 6-20
viewing printed jobs 6-12
Job menu commands 6-13, 6-16
job overrides
CMYK Simulation Method option A-4
job settings, see print options
Jobs Saved in Printed Queue 6-15

L
LaserWriter printer, fonts installed on 5-8
LCD 1-1
line selection buttons 1-2
lp command 4-2
lpq command 4-1, 4-2, 4-3
lpr command 4-1
lprm command 4-1, 4-3

M
Mac OS
Chooser C-4
PostScript printer setup 3-3 to 3-5
Printer Specific Options menu 3-5
printing 3-1 to 3-7
PDF files 2-25, 3-7
downloading 5-1
font substitution 5-9
performance, optimizing C-2
Phosphors option A-6
Photographic rendering style A-8, A-12
Photoshop, transfer functions 5-7
PostScript xiii
downloading files 5-1
downloading files, Mac OS 3-7
downloading files, Windows 2-25
error 6-15
icon 6-14
printing files from UNIX 4-1
PostScript printer description files, see PPD files
PostScript printer drivers
description xiv
Windows 2000 2-18
Windows 95/98 2-1
Windows NT 4.0 2-14
power switch 1-6
PPD (PostScript Printer Description) files xiv
Presentation rendering style A-8, A-12
press standards A-10
Preview command 6-13
previewing
jobs 6-19, A-5
Print area 6-11
icons 6-15
Print command 6-13, 6-16
Printed queue 6-12, 6-15
printer (job) icon 6-14
printer default settings xv, 3-5, A-1 to A-13
Mac OS 3-5
Windows 2000 2-20
Windows 95/98 2-4
Windows NT 4.0 2-16
printer driver, see PostScript printer drivers
printer settings, customizing 6-13

Paper
sizes supported A-7
parallel port
printing problems C-5
printing with 2-23
passwords
Administrator 6-3
Operator 6-3, 6-10

Power switch 1-6
PPD (PostScript Printer Description) files xiv
Presentation rendering style A-8, A-12
press standards A-10
Preview command 6-13
previewing
jobs 6-19, A-5
Print area 6-11
icons 6-15
Print command 6-13, 6-16
Printed queue 6-12, 6-15
printer (job) icon 6-14
printer default settings xv, 3-5, A-1 to A-13
Mac OS 3-5
Windows 2000 2-20
Windows 95/98 2-4
Windows NT 4.0 2-16
printer driver, see PostScript printer drivers
printer settings, customizing 6-13

Printing
screen fonts 5-8
Mac OS 3-5
Media option A-5
Media Saver Mode option A-6, A-11
Media Width option A-6
Menu button 1-2
Mirror option A-5

None simulation goal A-10
Notes 2-4
Notes fields A-6
Mac OS 3-4
Windows 95/98 2-4

On/off switch 1-6
Open Fiery command 6-13
Operator password 6-3, 6-10
(Other) Gamma option A-6, A-12
(Other) Phosphors option A-6, A-12
Other setting, RGB Source Profile option A-12
(Other) White Point option A-6, A-12
Output Profile option A-6
Override Print Settings command 6-13, 6-17
Owner Information 2-4

Page Range option A-1
Paper
sizes supported A-7
parallel port
printing problems C-5
printing with 2-23
passwords
Administrator 6-3
Operator 6-3, 6-10

PDF files 2-25, 3-7
downloading 5-1
font substitution 5-9
performance, optimizing C-2
Phosphors option A-6
Photographic rendering style A-8, A-12
Photoshop, transfer functions 5-7
PostScript xiii
downloading files 5-1
downloading files, Mac OS 3-7
downloading files, Windows 2-25
error 6-15
icon 6-14
printing files from UNIX 4-1
PostScript printer description files, see PPD files
PostScript printer drivers
description xiv
Windows 2000 2-18
Windows 95/98 2-1
Windows NT 4.0 2-14
power switch 1-6
PPD (PostScript Printer Description) files xiv
Presentation rendering style A-8, A-12
press standards A-10
Preview command 6-13
previewing
jobs 6-19, A-5
Print area 6-11
icons 6-15
Print command 6-13, 6-16
Printed queue 6-12, 6-15
printer (job) icon 6-14
printer default settings xv, 3-5, A-1 to A-13
Mac OS 3-5
Windows 2000 2-20
Windows 95/98 2-4
Windows NT 4.0 2-16
printer driver, see PostScript printer drivers
printer settings, customizing 6-13

Presentation rendering style A-8, A-12
press standards A-10
Preview command 6-13
previewing
jobs 6-19, A-5
Print area 6-11
icons 6-15
Print command 6-13, 6-16
Printed queue 6-12, 6-15
printer (job) icon 6-14
printer default settings xv, 3-5, A-1 to A-13
Mac OS 3-5
Windows 2000 2-20
Windows 95/98 2-4
Windows NT 4.0 2-16
printer driver, see PostScript printer drivers
printer settings, customizing 6-13
printer setup
  Mac OS 3-3 to 3-5
  settings 2-16, 2-20
  Windows 2000 2-18 to 2-20
  Windows 95/98 2-1 to 2-5
  Windows 95/98 2-2 to 2-14
  Windows NT 4.0 2-15 to 2-17
Printer Specific Options menu 3-5
printing
  Configuration page 1-5
  font list 1-5, 5-3
  from Fiery Downloader 3-7, 5-4
  list of fonts 5-10
  Mac OS 3-1 to 3-7
  parallel port 2-23
  saving files for printing at remote location 2-24
  server information pages 1-4
  to File Port 2-24
  to local port 2-24
  troubleshooting C-3 to C-5, C-7 to C-8
  UNIX workstations 4-1 to 4-3
  Windows 2000 2-18
  Windows 95/98 2-1
  Windows NT 4.0 2-14
printing, defined xiii
printing connections on the network xv
Print Job Log command 6-13
print jobs
  deleting from queue 6-13
  previewing 6-19
Print Mode option A-7
Print Monitor Ink Status 6-6
Print Monitor WebTool 6-6
print options A-1 to A-13
  Mac OS 3-3 to 3-5
  Windows 95/98 2-2 to 2-14
  see also printer default settings
Print Pages command 1-4
  Control Panel 1-4
Print queue xv
Print Status screen 1-3
Process Next command 6-13, 6-16
Pure Black Text/Graphics option A-7
Q
Queue option 5-5
queues 6-12
queues, access to xv
Queues window
  spooled jobs 6-12
R
RAM
  in use 6-11
  total 6-11
raster
  icon 6-14
Reboot Server command, from Control Panel 1-5
Remove Raster command 6-13, 6-17
Rename command 6-13, 6-16
Rendering Style option A-8
RGB Source option A-8
RGB Source Profile option A-12
RIP, defined xiii
RIP area 6-11
RIP Mode option A-8
RIP Status screen 1-3
S
Saved Settings 2-5
Scale option A-8
Scaling option A-13
Screen Method option A-9
separations, printing A-4
server
  restarting 1-7
  shutting down 1-7
setting print options
  Windows 2000 2-18 to 2-20
  Windows 95/98 2-1 to 2-5
  Windows NT 4.0 2-15 to 2-17
Shortcuts 2-10
Show Job List command 6-13
Show Job Log command 6-13
Show menu (Mac OS) 5-5
showpage after EPS files option 5-7
simulations, custom A-10
SMB printing 2-2, 2-14, 2-18
Solaris 2.x 4-3
Solid Color rendering style A-8
spool, defined xiii
Spool area 6-11
job icons 6-14
spooled jobs 6-12
displayed in Fiery WebSpooler 6-12
icons 6-14
Spooler, see Fiery Spooler
Spot Color Matching option A-9, A-13
sRGB (PC) setting, RGB Source Profile option A-12
starting the server 1-6
status bars 6-11, 6-12
Print 6-11
RIP 6-11
Spool 6-11
status screens, Control Panel 1-3
Status WebTool, see Fiery WebTools
Stochastic screen method A-9
SunOS 4.1.x 4-3
SWOP-COM/F simulation A-10
SWOP-COM/M simulation A-10
T
TCP/IP printing 4-1
Test Page
printing from Control Panel 1-4
Thumbnail A
page display 6-19
Thumbnail A command 6-13, 6-17
Thumbnail B command 6-13, 6-17
troubleshooting
color output C-6
Fiery Downloader C-7 to C-8
Fiery Spooler C-7
genral printing problems C-3 to C-5
problems with print quality C-5 to C-6
Two-Way communication 2-3
U
Undo command 6-13
UNIX
BSD (Berkeley Software Distribution) variant of 4-3
displaying jobs in queue with 4-2
printing from 4-1 to 4-3
removing jobs from queue with 4-3
System V 4-3
up button 1-2
user software xv
W
WebLink, see Fiery WebTools
WebSetup WebTool, see Fiery WebTools
WebSpooler, see Fiery WebTools
WebTools, see Fiery WebTools
White Point option A-6
Windows 2000
printer default settings 2-20
printing with 2-18
setting print options 2-18 to 2-20
Windows 95/98
Notes fields 2-4
PostScript printer driver 2-1
printer default settings 2-4
printing with 2-1
setting print options 2-1 to 2-5
Windows NT 4.0
printer default settings 2-16
printing with 2-14
setting print options 2-15 to 2-17
WINS printing 2-1